
PART 7 — CONTENTS

55 Preparing Timelines for Import and Comparison   �������������������������������������������������  1056

56 Conforming and Relinking Clips   ���������������������������������������������������������������������������������  1070

57 Creating Digital Dailies for Round Trip Workflows  �����������������������������������������������  1097

58 Conforming XML Files  ����������������������������������������������������������������������������������������������������  1104

59 Conforming AAF Files  �����������������������������������������������������������������������������������������������������  1109

60 Conforming EDL Files  �����������������������������������������������������������������������������������������������������  1124

61 Conforming OTIO Files   �������������������������������������������������������������������������������������������������� 1131

62 Conforming ADL Files  ����������������������������������������������������������������������������������������������������  1136

Import and 
Conform Projects



Chapter 55

Preparing 
Timelines for Import 
and Comparison
Generally speaking, “conforming” a project describes the process 
of importing a project exchange file from another post-production 
application, and automatically relinking each clip in the imported 
timeline to the high-quality media files each clip corresponds to.

If you need to continue editing, color correct, or finish a project that was put together in another 
application, you can import via the EDL, AAF, or XML project exchange formats. When you go through 
the process of conforming a project, you use the imported project data to arrange the clips in the 
Media Pool into a timeline that constitutes the program that’s about to be graded.

This chapter walks you through the process of preparing timelines in other applications prior to 
moving them into DaVinci Resolve and covers which effects have counterparts in the DaVinci Resolve 
timeline. It ends with instructions on how to set up to compare a reference movie to the Timeline. 
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Preparing to Move Your Project 
to DaVinci Resolve
When you’re preparing to move a project from another NLE to DaVinci Resolve, there are a few steps 
you can take to make your work more organized.

Move Clips to the Lowest Video Track
Editors often use the multiple tracks NLEs offer for simple clip organization in the edit of a scene. 
While this is convenient for offline editorial, it is less convenient when you’re trying to conform, grade, 
finish, and render the media used by a project as quickly and efficiently as possible.

For this reason, it’s a good idea to move all clips that are not stacked or superimposed as part of a 
compositing operation down to track V1 of the Timeline in your NLE. This produces a simplified edit 
that has many advantages. The project becomes smaller to move because there’s less media in the 
Timeline, and consequently becomes faster to render. Furthermore, the colorist is spared confusion 
because this eliminates “hidden” media that is nonetheless connected to other clips that can be seen.

It’s also helpful, once you’ve reorganized the Timeline, to eliminate any empty tracks that are left. 
This can be done from within DaVinci Resolve, but doing it in your NLE further simplifies the project 
import process.

1057Import and Conform Projects | Chapter 55 Preparing Timelines for Import and Comparison



Organize Unsupported Media Files
Depending on your workflow and on the NLE you’re working with, there may be clips using formats 
that are unsupported in DaVinci Resolve. Unsupported generators, media formats, and other effects 
constructs may simply not be seen in DaVinci Resolve, and will consequently appear as unlinked clips.

If you know this in advance, you can move all such clips into dedicated tracks where they can be 
isolated, and the track can be turned off to hide the unsupported clips, simplifying timeline navigation. 
This also saves the colorist from the need to worry about why there are offline clips in the Timeline at 
3 o’clock in the morning, immediately before starting a render.

Creating an Offline Reference Movie
Even though the colorist in any given workflow is likely to be building new grades from scratch, it 
can be valuable to have a reference movie showing any color corrections, filters, or effects that 
the offline editor applied during the editing process. This offline reference can be imported into a 
DaVinci Resolve project, and used as a split-screen reference whenever there’s some question about a 
look or effect from the offline edit.

Offline reference movies also serve as a useful tool when conforming a project in the Edit page. After 
project conform, you can compare the project as seen in the Record Viewer with the synchronized 
offline movie as seen in the Source Viewer set to Offline mode. This makes it easy to scrub through a 
project to make sure that each clip has imported correctly and is in sync. 

More information about using offline reference movies appears later in this chapter.

Mixed Frame Sizes and Mixed Codecs
Most NLEs can freely mix media using different frame sizes, different codecs, and different frame 
rates. DaVinci Resolve deals with these combinations in different ways, depending on what settings 
you’ve selected in the Project Settings.

 — Mixing Frame Sizes: Mixed frame sizes are easily handled. The Set Timeline Resolution To 
parameter in the Project Settings panel of the Project Settings dictates the current resolution 
of the project. Any clips with a frame size that doesn’t match the project is resized according to 
the option selected in the Image Scaling panel of the Project Settings. You can, of course, always 
manually readjust the sizing of any clip if you want to make a specific adjustment. All resizing is 
done using the optical-quality resizing algorithms in DaVinci Resolve. For more information, see 
Chapter 150, “Sizing and Image Stabilization.”

 — Mixing Codecs: Mixed codecs are also not a problem, as long as the different codecs used by 
the media in the project you’re importing are compatible with the list of codecs and formats that 
DaVinci Resolve supports. For more information about the currently supported list of codecs and 
formats, check the Blackmagic Design support page for DaVinci Resolve. This list is updated often 
with newly supported formats.

Mixed Frame Rates
DaVinci Resolve also supports mixed frame rates, although there is a setting you must choose to 
ensure the best results for the NLE you’re importing from. By default, mixed clip frame rate support 
is enabled via the “Mixed frame rate format” pop-up menu that appears either in the Master Project 
Settings, or in the Import AAF or XML dialog. 
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The different options available in the “Mixed frame rate format” pop-up are available to let you 
conform projects using the method of mixed frame rate calculation used by the NLE a project was 
originally edited in; different NLEs have different ways of mixing frame rates, and that used by Final 
Cut Pro 7 is different from that used by Final Cut Pro X or Avid Media Composer. If you need to change 
this setting, you must do so before you import any media into the Media Pool; once the Media Pool is 
populated, this setting can no longer be changed.

Mixed frame rate format selection

This Mixed frame rate format pop-up menu is also found in the Load AAF and Load XML dialogs. 
DaVinci Resolve automatically chooses a setting from the “Mixed frame rate format” pop-up menu 
that corresponds to the project file you’re importing, but in some cases you can override this setting 
if necessary. For projects sent from Final Cut Pro, you can choose either “Final Cut Pro 7” or “Final Cut 
Pro X” to match the type of project you’re importing. On the other hand, you should choose “Resolve” 
for projects imported from Premiere Pro, Smoke, Media Composer, or other NLEs.

When “Mixed frame rate format” is set to anything but None, DaVinci Resolve conforms and processes 
all clips in the Timeline to play at the project’s frame rate. For example, 23.98, 29.97, 30, 50, 59.94, 
and 60 fps clips will all play at 24 fps if that’s what “Timeline frame rate” is set to in the Master Project 
Settings. Clips with different source frame rates will be retimed to match the Timeline conform 
frame rate. 

The Retime process that’s used to render clips with differing frame rates can be changed for individual 
clips via the Retime Process parameter in the Edit page Inspector, or it can be changed project-wide 
using the Retime Process parameter found in the Frame Interpolation panel of the Master Project 
Settings. For more information on how each of the three available options work, see the “Frame 
Interpolation” section of Chapter 4, “System and User Preferences.” 

If you choose “None,” then clips with frame rates that aren’t equal to the Timeline frame rate will 
ignore their original frame rate and will play at the Timeline rate, resulting in either faster or slower 
motion, depending on the difference between the original and Timeline frame rates.
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NOTE: Because DPX files often either lack or have incorrect frame rate information in 
the header data, you may need to select None when conforming a project using image 
sequences to make sure your media is not incorrectly interpreted.

How clips in mixed frame rate timelines are rendered depends on whether the Render Settings are set 
to render individual source clips or one single clip. When you render the Timeline as ”Individual Source 
Clips,” then all clips are rendered individually at their original frame rate. If you select ”Single Clip,” 
then all clips are converted to the “Timeline frame rate” frame rate setting, and rendered as a single 
media file.

Importing Effects when 
Conforming Edits
DaVinci Resolve is capable of translating a subset of the effects exported within XML, AAF, and EDL 
project files into their DaVinci Resolve equivalents. The following chart illustrates which effects are 
supported, and for which project import formats.

Unsupported effects are neither imported nor displayed in DaVinci Resolve. However, the majority of 
unsupported effects are preserved internally, and are reinserted into exported XML or AAF files so 
that those effects will reappear in your NLE once the project is reimported.

EDL FCP 7 XML FCP X XML AAF

Color Corrections No No Yes No

Composite Modes No Yes Yes Overlay only

Multiple Tracks No Yes Yes Yes

Video Transitions Yes Yes Yes Yes

Audio Transitions No No No Yes

Opacity Settings No Yes Yes
Yes, via 3D Warp or 

Superimpose

Position, Scale, Rotation No Yes Yes Yes, via 3D Warp

Flip and Flop No No No
Yes, via Flip, Flop, or 

Flip-Flop effects

Pitch and Yaw No No No Yes, via 3D Warp

Linear Speed Effects Yes Yes Yes Yes

Variable Speed Effects No Yes Yes Yes

Still Image Clips No
All supported 

formats in Resolve
All supported 

formats in Resolve
All supported  

formats in Resolve

Freeze Frames No No No Yes
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EDL FCP 7 XML FCP X XML AAF

Nested Sequences No Yes Yes No

Linked Clip Audio Yes Yes Yes Yes

Mixed Frame Rates No Yes Yes Yes

Text Generators No Yes Yes No

Effects supported with imported AAF, XML, and EDL

About Supported Color Corrections
At the time of this writing, only Final Cut Pro X XML projects are capable of exporting color correction 
data that can be imported as primary grades in DaVinci Resolve. For obvious reasons, color correction 
import is a one-way street, and imported color corrections cannot be output back to Final Cut Pro. 
Imported Final Cut Pro X color adjustments appear in the Color page as primary corrections.

Other workflows for importing color correction information from other applications are available 
using ColorTrace to import grade data from CDLs (Color Decision Lists). For more information, 
see the “Copying Grades Using ColorTrace” section in Chapter 186, “Copying and Importing Grades 
Using ColorTrace.”

About Supported Transitions
EDLs are the most restrictive when it comes to transition support in DaVinci Resolve, as only Cross 
Dissolves will be read. Any other transitions appearing in an EDL will be automatically converted to a 
Cross Dissolve of the same duration when it’s imported into DaVinci Resolve.

On the other hand, DaVinci Resolve supports the import of ten different transitions when importing 
XML project files from Final Cut Pro X and legacy Final Cut Pro 7, or nine different transitions when 
importing AAF files from Avid Media Composer or Symphony.

EDL FCP XML AAF

Clock Wipe No Yes Yes

Center Wipe No Yes Yes

Cross Dissolve Yes Yes Yes

Additive Dissolve No Yes No

Dip to Color Dissolve No Yes Yes

Edge Wipe No Yes Yes

Venetian Blind Wipe No Yes Yes

Cross Iris No Yes Yes

Diamond Iris No Yes Yes

Oval Iris No Yes Yes

Supported transitions for imported EDL, XML, and AAF
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Transition Names
To help you prepare projects for export, note that the names of transitions vary between XML 
and AAF project files. Here are the supported transitions as they appear in Avid Media Composer 
and Symphony.

Dip to Color Dissolve Dip to Color effect in the Blend category

Edge Wipe
Horizontal/Vertical/Lower Left/Lower Right/Upper Left/Upper Right Diagonal 
effects in the Edge Wipe category

Center Wipe Horizontal Open and Vertical Open effects in the Edge Wipe category

Clock Wipe Clock effect in the Shape Wipe category

Venetian Blind Wipe Vertical Blinds and Horizontal Blinds effects in the Shape Wipe category

Cross Iris 4 Corners effect in the Shape Wipe category

Diamond Iris Diamond effect in the Shape Wipe category

Oval Iris Circle effect in the Shape Wipe category

About Supported Opacity, Position, 
Scale, and Rotation Settings
When importing XML project files from Final Cut Pro X, Premiere Pro, or legacy Final Cut Pro 7, 
DaVinci Resolve supports the import of Opacity, Position, Scale, and Rotation settings. Imported 
Composite and Transform settings for any given clip appear in the Inspector of the Edit page, or in the 
Edit Sizing mode of the Sizing palette in the Color page. If these settings have been keyframed, the 
animation will appear in DaVinci Resolve.

When importing AAF files from Media Composer or Symphony, DaVinci Resolve supports the 
import of Opacity, Resize, and 3D Warp effects, which are converted into Pan, Tilt, Zoom, and Rotate 
settings in DaVinci Resolve, located in the Edit page Inspector or the Edit Sizing mode of the Sizing 
palette in the Color page. 

About Flip and Flop Support
When importing AAF project files from Media Composer or Symphony, Flip, Flop, and Flip-Flop effects 
are converted into the equivalent horizontal and vertical Flip toggles in DaVinci Resolve, located in the 
Edit page Inspector or the Edit Sizing mode of the Sizing palette in the Color page.

Pitch and Yaw
When importing AAF files from Media Composer or Symphony, DaVinci Resolve supports the import 
of Pitch and Yaw 3D Warp effects, which are converted into equivalent Pitch and Yaw settings in 
DaVinci Resolve, located in the Edit page Inspector or the Edit Sizing mode of the Sizing palette in the 
Color page.
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About “Ken Burns Effect” and Dynamic Zoom
If you import a project from Final Cut Pro X with clips that use the Ken Burns effect for creating pan 
and scan animation, then the Dynamic Zoom parameters (found in the Edit page Inspector when a clip 
is selected) for each affected clip will be populated with an equivalent animated effect.

About Speed Effects
DaVinci Resolve supports the import of speed effects from different applications, but different project 
formats have different speed effect support.

 — EDL: DaVinci Resolve only supports the import of linear speed effects when importing EDLs. 

 — XML: DaVinci Resolve supports the import of both linear and variable speed effects when 
importing XML project files from Premiere Pro, Final Cut Pro 7, and Final Cut Pro X. As of 
DaVinci Resolve version 11.1, XML from Final Cut Pro X can also provide information about whether 
frame blending or optical flow is used, as well as information about the Bezier curve transitions of 
speed effects.

 — AAF: DaVinci Resolve supports the import of both linear and variable speed effects when 
importing AAF files from Media Composer or Symphony that use Timewarp effects.

DaVinci Resolve has high-fidelity conversion of variable-speed speed effect data from other 
applications, accomplished by creating one speed keyframe per frame for each affected clip. However, 
you may see small variations between the resulting speed effect in DaVinci Resolve and an offline 
reference movie exported from the original NLE if you haven’t set the Retime Process setting to the 
same type of speed interpolation that the original NLE was using. 

In other words, if you created a Timewarp speed effect in Media Composer that uses FluidMotion to 
create smooth slow motion effects, then you’ll want to make sure to change either the project-wide 
or clip-specific Retime Process setting to Optical Flow so that the speed effects in DaVinci Resolve best 
match those in Media Composer. For more information on speed effects in DaVinci Resolve,  
see Chapter 51, “Speed Effects.”

About Nested Sequences and Compound Clips
DaVinci Resolve supports the import of compound clips from Final Cut Pro X and of nested 
sequences from legacy Final Cut Pro 7. Both appear within DaVinci Resolve as compound clips, 
in both the Timeline and the Media Pool. Compound clips with mixed frame rates are supported, 
as well as multi-cam and A/V synchronized clips from Final Cut Pro X, which are represented in 
DaVinci Resolve as compound clips. For more information about creating and using compound clips in 
DaVinci Resolve, see the “Compound Clips” section of Chapter 42, “Take Selectors, Compound Clips, 
and Nested Timelines.”

About Supported Composite Modes
When importing XML project files from Final Cut Pro 7, Premiere Pro, and Final Cut Pro X, 
DaVinci Resolve supports the import of eight different composite modes. When importing AAF files 
from Media Composer, the Overlay composite mode is supported when the source AAF file has a 
Superimpose effect applied to it.
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FCP 7/X XML AAF

Add Yes No

Subtract Yes No

Difference Yes No

Multiply Yes No

Screen Yes No

Overlay Yes Yes

Lighten Yes No

Hardlight Yes No

Softlight Yes No

Darken Yes No

Supported composite modes with imported XML and AAF 

About Supported Still Image Formats
DaVinci Resolve supports the import of greater-than-one-frame-in-duration TIF, JPG, PNG, DPX, TGA, 
and DNG still image files that appear in Final Cut Pro X, Final Cut Pro 7, and Premiere Pro XML files, and 
AAF files exported from Media Composer. These clips appear as ordinary clips in the DaVinci Resolve 
Timeline. Export of still images is limited to Final Cut Pro 7 and Final Cut Pro X XML formats.

About Supported Alpha Channels
Media with embedded alpha channels is supported for any project as long as it’s in a media format 
that DaVinci Resolve supports; this includes TIFF, OpenEXR image sequence formats, and four-channel 
QuickTime formats such as ProRes 4444, DNxHR 444, and QuickTime Animation. Alpha channels are 
automatically enabled, and can be used for compositing directly within the DaVinci Resolve Timeline.

Alpha channels can be exported in round-trip workflows when rendering individual source clips. 
However, when rendering a program as a single clip, all composited effects are rendered together to 
produce a single output media file. For more information on rendering clips with alpha channels, see 
Chapter 185, “Delivery Effects Processing.”

About Imported Text Effects
DaVinci Resolve supports the import of text generators when importing XML project files from both 
Final Cut Pro X and Final Cut Pro 7. All imported text effects appear in the DaVinci Resolve Timeline 
as Basic text generators. Some, but not all, formatting parameters are imported, depending on the 
project file format being imported.

About Imported Audio in AAF Projects
Any combination of audio track types, channel map order, MXF and QuickTime files, and rendered or 
unrendered clips should import without problems.
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NOTE: When exporting an AAF project, DaVinci Resolve is capable of writing mono media 
in stereo tracks.

Preparing Unsupported Clips and Effects You Want to Grade
If there is an unsupported effect within your NLE of choice that you want to move into DaVinci Resolve 
for grading (for example, clips with effects filters that are native to a particular NLE), here’s a simple 
workflow to follow.

To “bake” an effect into a clip you’re sending to DaVinci Resolve:

1 Export that clip as a self-contained media file using whatever DaVinci Resolve-compatible 
mastering codec you prefer.

2 Reimport the resulting media file into your project.

3 Edit it into your project’s timeline to replace the original effects clip.

4 Export a version of the resulting sequence for use in DaVinci Resolve.

This is a good way of prepping the titles and effects of projects that you want to finish in 
DaVinci Resolve. If you create self-contained media files for all title clips and effects, then these 
elements will import cleanly and easily, and you can export a complete, texted version of your 
program out of DaVinci Resolve.

Additionally, if a composited clip is using unsupported effects (for example, a filtered still image with 
animated position that’s superimposed using the Overlay composite mode and set to 70% opacity), 
an ideal way to prep this clip for XML export to DaVinci Resolve is to set the composite mode to 
Normal, set Opacity to 100%, and then export the resulting clip as a self-contained QuickTime movie. 
Reimport the result, edit it back into the Timeline to replace the original superimposed clip, and then 
set its composite mode to Overlay and its Opacity to 70% to match the original settings. Now the 
unsupported effects are “baked” into the clip, but the effects that DaVinci Resolve does support are 
still live, and can be readjusted in context while grading.

Verifying Imported Timelines 
Using Offline References
DaVinci Resolve has a specific interface for comparing two versions of a program. This eliminates the 
need to edit a rendered version of a timeline as a superimposed clip within your timeline and provides 
many other features to aid this comparison without cluttering your timeline. 

By setting the Source Viewer in the Edit page to Offline mode, you can compare an Offline Reference 
Clip or Timeline to a currently open timeline, with both playheads ganged together, either side by side, 
or as a split screen, a box wipe, or difference operation, all of which will be visible via your video output 
device. As you play the Timeline, the Offline Reference Clip or timeline plays as well, making it easy to 
spot differences between the two. 
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IMPORTANT: You need to make sure that the media you’ve imported or are using as 
an Offline Reference Clip has a valid timecode track with a start time that matches the 
timecode of the Timeline you’re comparing to, otherwise there will be an offset between 
the Timeline and offline reference that will make a comparison difficult to impossible. Small 
offsets can be corrected via an offset field in the Source Viewer while in offline mode, but 
large offsets will be impractical to correct.

Why Set Up An Offline Comparison?
However you set up an offline reference, this is a convenient way of comparing two versions of a 
program. There are several reasons for comparing an Offline Reference Clip to a timeline:

 — Verifying the clip order: If you’re unsure whether or not you’ve properly resolved reel conflicts 
or other problems that occurred while you were conforming a timeline, you can compare each edit 
to the offline version of the program to spot problems and identify the proper media that should 
correspond to any clip.

 — Recreating effects: If there are offline effects, such as temporary grades made in the NLE, or pan 
and scan transforms that you want to check, the Offline reference mode lets you split-screen your 
current grade against the Offline Reference Clip in the Color page.

 — Comparing two versions of a timeline: You can make a visual comparison a timeline with 
another version of that timeline to spot differences for evaluation.

 — Filling holes in timelines with missing or unlinked clips: Two options found in the Master 
Project Settings panel of the Project Settings, “Show offline clips through conform gaps,” and 
“Show offline clips through missing clips,” let you set DaVinci Resolve to display Offline Reference 
Clip media to fill gaps in the Timeline or replace the contents of unlinked clips. This is typically 
done to resolve emergency situations when you need to proceed with a screening or review 
session despite the fact that you’re missing media for whatever reason. For more information,  
see Chapter 4, “System and User Preferences.”

NOTE: Typically, the flattened version of the program you’re given uses a low-quality 
codec, and contains effects and color correction that’s not final, which is why it’s called an 
Offline Reference Clip.

Assigning a Clip or Timeline for Offline Comparison
There are two ways you can assign an Offline Reference Clip or Timeline to a particular timeline for 
comparison. The easiest and most flexible way is to open a timeline, and then drag and drop a clip or 
timeline with matching timecode that you want to compare to from the Media Pool onto the Source 
Viewer in Offline mode.

To assign any clip or timeline to a specific timeline for comparison:

1 Open the timeline you want to make the assignment to in the Edit page.

2 Set the Source Viewer to Offline mode.
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3 Drag a clip or timeline with matching timecode that you want to assign onto the Source Viewer. 
The clip or timeline you dragged is immediately assigned to the open timeline as an Offline 
Reference Clip, and synced via timecode.

4 In the Media Pool, right-click the Timeline you want to review against the Offline Reference Clip, 
and choose the reference clip or timeline you assigned from the Timelines > Link Offline Reference 
Clip submenu of that timeline’s contextual menu.

You can also add a clip to the Media Pool specifically as an Offline Reference Clip, making it easy 
to associate such a clip with a particular timeline by right-clicking that timeline in the Media Pool 
and choosing it from the Link Offline Video submenu. The idea is that if you or your client exports 
a flattened version of their edited sequence at the same time as they export the EDL, AAF, or 
XML project file they want graded, then you can compare the project data that’s imported into 
DaVinci Resolve to the actual video of the offline edit.

To assign an imported Offline Reference Clip to a specific timeline for comparison:

1 Open the Media page, and use the Media Storage browser to find the flattened Offline Reference 
Clip that you want to use for comparison.

2 Right-click the Offline Reference Clip file and choose Add as Offline Reference Clip.

3 That clip appears with a small checkerboard badge in its icon in the Media Pool.

Checkerboard indicating  
an offline video

4 Open the Edit page, right-click the timeline you want to review against the Offline Reference 
Clip, and choose the offline clip you imported from the Timelines > Link Offline Reference 
Clip submenu.

Selecting the offline video to link to the current Timeline
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Setting Up an Offline Reference/
Timeline Comparison
Once you’ve assigned a clip or timeline as an Offline Reference Movie, it’s easy to see a comparison.

To view an offline reference comparison:

1 Open the Source Viewer’s Mode pop-up menu and choose the checkerboard icon 
indicating Offline Reference.

Selecting the Offline video 
in the Source Viewer

The Offline Reference Clip you assigned previously now appears within the Offline Viewer, and 
plays back in sync with the Timeline. If your clips have sizing applied, have Fusion or other effects, 
or are graded, you can see a side-by-side comparison between the state of each clip in the Offline 
Reference Clip, and the graded Timeline clip.

The Edit page in Offline/Timeline mode

2 If the currently selected Offline Reference is out of sync (which can be confirmed via the position 
of a slate, two-pop, title, or other known shared sync point at the beginning of the program), you 
can use the sync field at the upper left-hand corner of the Source Viewer in Offline mode to slip 
the sync of the reference by whatever number of frames you need.
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3 If you like, you can optionally choose other ways of comparing clips, by right-clicking anywhere 
within the Timeline Viewer and choosing Vertical Wipe, Horizontal Wipe, Diagonal Wipe, Mix Wipe, 
Difference (a Composite mode), Box (wipe), Venetian Blind, or Checkerboard. These modes offer 
you different ways of quickly and directly comparing the content, sizing, color, and alignment of 
the Offline Reference Movie to the clips in your timeline.

Different viewing options for comparing the Offline Reference Movie to the 
Timeline are available in the Timeline Viewer contextual menu

If you choose a wipe or difference comparison, that comparison will also be visible on the display 
connected to your video output interface, and dragging anywhere within the Timeline Viewer will 
adjust the ratio and position of the wipe.

4 To turn an offline comparison viewer mode off, simply right-click the Timeline Viewer again and 
choose No Wipe.

5 When you’re done doing this offline comparison, choose Source from the Source Viewer’s Mode 
pop-up menu, and the Source Viewer is ready for viewing clips from the Media Pool, as normal.
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Chapter 56

Conforming and 
Relinking Clips
Whether you import a DaVinci Resolve project or a project 
exchange file from another application, you’ll need to deal with the 
need to relink media files in the Media Pool and reconform timelines 
to either the same or compatible media files that may either be in 
the Media Pool or that may need to be imported from disk.

This chapter discusses the rules with which DaVinci Resolve conforms clips to match timelines, and 
describes the numerous methods with which you can control clip linking, timeline conform, as well 
as how you can deal with problems that arise using the numerous problem-solving techniques that 
DaVinci Resolve makes available.
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Conforming and Relinking Media
DaVinci Resolve provides a wealth of tools to help you deal with managing the relationship 
between clips in the Media Pool and clips in timelines, and with the links between each clip and its 
corresponding media file on disk. You can use these tools to manage different project workflows, 
or to deal with problems that can occur when importing project files in any format from a variety 
of sources. 

This section describes every method available in DaVinci Resolve for conforming clips and relinking 
media. More information on the clip metadata that’s used to determine the correspondences between 
clips and media is found later in this chapter.

Conforming and Relinking During Project Import
When you import an AAF or XML file, you have the ability to relink the clips that are imported into the 
Media Pool to the corresponding source media files on disk as part of the process. As an automatic 
result, the imported timeline is conformed to the clips in the Media Pool, and you end up with a Media 
Pool full of clips, and an arrangement of those clips in the imported timeline. Because it all usually 
happens at the same time, it’s easy to confuse the distinction between a timeline’s relationship to the 
clips in the Media Pool, and each clip’s relationship to their corresponding source media file on disk.

The workflow for importing an EDL makes this process more explicit, since you must first import all 
of the clips you need into the Media Pool, making sure that they have the correct reel names and 
timecode. This creates the link between the Media Pool clips and the source media on disk. You then 
import the EDL in a second step, which creates a timeline that attempts to reconform itself to the clips 
in the Media Pool using reel name and timecode information.
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Conforming and Relinking Existing 
Timelines and Clips
There are many reasons why you might want to reconform or relink media long after you’ve started 
editing or grading a project, so DaVinci Resolve provides additional tools to facilitate these workflows 
as well. For example, you may have started a project using placeholder VFX or stock footage clips, 
but you later need to replace these with final versions of the same shots. Or, you may have decided 
to edit a project using transcoded versions of the camera raw media files you were given, only to 
decide later that you want to switch one or all of the clips in the timeline to use the original camera 
media instead for grading and finishing. DaVinci Resolve has a wide variety of tools to support these 
workflows and more.

The Difference Between Conforming and Relinking
While these two terms are often used synonymously, conforming typically refers to the 
process of matching clips in a timeline to the appropriate source clips in the Media Pool, 
while relinking typically refers to the process of matching a source clip in the Media Pool to 
its corresponding media file on disk. This is a recent change necessitated by an expansion 
of relinking and reconforming options, so the author offers his apologies if this usage is not 
always consistent.

The Difference Between 
Unlinked and Missing Clips
While it may seem pedantic, there’s an important difference between clips that are unlinked, and 
clips that are missing when it comes to the relationship between clips in the Media Pool and clips in a 
Timeline. First off, both of these “offline” clip states look different in the timeline, but these differences 
aren’t just cosmetic.

A missing clip in the Timeline (left) compared to an unlinked clip in the Timeline (right)

An unlinked clip is a clip that exists in the Media Pool, but has lost the link to its corresponding media 
file on disk. However, unlinked clips still contain metadata, they still have a relationship to instances 
of that clip that have been edited into timelines in your project, and they can be easily relinked to 
media files with matching file names and timecode using the Relink command (described later), 
or reconformed to previously or newly imported clips in specific bins of the Media Pool with the 
Reconform From Bins command (also described later).
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Missing clips do not exist in the Media Pool at all, although clips flagged as missing can still appear in 
the timelines of your project. However, since missing timeline clips have no corresponding source clips 
in the Media Pool, the clip in the timeline has no metadata that can be seen in the Metadata Editor, 
and it will have lost any remote grades that are associated with that source clip (for more information 
about remote grades, see Chapter 139, “Grade Management.” You can fix missing clips in a timeline in 
one of two ways:

 — If the “Automatically conform missing clips added to Media Pool” setting is enabled in the General 
Options panel of the Project Settings, then simply reimport the corresponding source clips into 
the Media Pool and they will be automatically conformed to missing clips with matching timecode 
and file names in the timeline (this only happens at the time of import, it doesn’t work for 
matching clips that are already in the Media Pool). Please note, this setting must be disabled if you 
use collaborative workflow.

 — If the “Automatically conform missing clips added to Media Pool” setting is disabled in the General 
Options panel of the Project Settings, then you’ll have to import the missing clips and either 
manually reconform them one at a time to the missing timeline clips using the Conform Lock 
with Media Pool Clip command, or use the Reconform From Bin(s) or Import Additional Clips With 
Loose/Tight Filename Match commands to try reconforming them all at once.

However you choose to reconform the missing clips, you won’t get the original remote grades or 
manually edited metadata back unless you had previously exported the appropriate metadata and 
grades, in which case you can reimport and apply these in separate steps.

Duplicate Clips are Considered 
Separate Sources
Another thing that’s good to understand is that in DaVinci Resolve, duplicate clips are considered to 
be completely separate from the original Media Pool or Timeline clips you duplicated them from. For 
example, if you import five clips into Media Pool Bin 1, then edit them into a timeline, and then drag the 
five clips you edited into Media Pool Bin 2, the clips in Bin 1 are not intrinsically linked to the clips in Bin 2.

This means, if you select the clips you originally imported in Bin 1 and choose Unlink Selected Clips, 
the instances of those clips that you edited into the timeline will also be unlinked, but the duplicate 
clips you created when you dragged the timeline clips into Bin 2 are completely unaffected.

Summary of Methods for 
Conforming and Relinking
As a result of timelines and clips being managed separately, there are several ways you can reconform 
clips in a timeline to clips in the Media Pool, and clips in general to a project’s corresponding source 
media on disk. Which methods will be most valuable depend entirely on the workflow you’re using.

 — Conforming clips during XML and AAF import: When you import a project via AAF or XML, 
you’re given the option of using the embedded file paths in the AAF or XML file to import all 
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referenced media into the Media Pool for automatic reconforming to the clips in the imported 
timeline. If the media has been moved so that the file paths are invalid, then you’ll be asked to find 
the location of the media as part of the import process. You also have the option to ignore the 
AAF or XML file’s embedded file paths and instead import another set of media files in a different 
location (and perhaps in a different media format altogether) that have the same file names and 
timecode as the clips in the AAF or XML file you’re importing.

 — Importing clips before importing an EDL, AAF, or XML: In EDL workflows, you must import the 
media an EDL will be conformed to into the Media Pool before you import the EDL. However, you 
can do this for AAF and XML import workflows as well. When you import clips into the Media Pool 
before importing an AAF or XML, DaVinci Resolve is able to automatically reconform the clips in 
the imported timeline to those in the Media Pool first, before next looking for media on disk for 
clips that could not be found in the Media Pool. This behavior depends on what options you’ve 
selected in the Import AAF/EDL/XML dialog.

 — Conform missing clips by importing their source media into the Media Pool: As long as 
the “Automatically conform missing clips added to Media Pool” setting is enabled in the General 
Options panel of the Project Settings, DaVinci Resolve automatically tries to update the conformed 
relationship between clips you’re adding to the Media Pool and any missing clips in the various 
timelines of your project. This behavior is triggered whenever you add clips to the Media Pool by 
importing clips, copying and pasting, or creating duplicates of clips. For example, if a timeline clip 
is missing because there is no corresponding clip in the Media Pool, the simple act of importing a 
clip with a matching file name and timecode into the Media Pool will automatically reconform the 
missing timeline clip without you needing to do anything else. Please note, the “Auto conform clips 
with media added into Media Pool” setting must be disabled if you use collaborative workflow.

 — Using the Import Additional Clips commands: The process of importing media just for missing 
clips in a timeline can be automated by right-clicking that timeline in the Media Pool and using 
the Timelines > Import > Additional Clips With Loose (or Tight) Filename Match contextual menu 
commands, which automatically search the selected directory tree of your file system for media 
that matches all of the offline clips in that timeline. The “Loose Filename Match” command ignores 
file extensions (letting you conform to alternate media formats), while the “Tight Filename Match” 
command requires file extensions to match.

 — Reconform online clips by importing new media into the Media Pool: As long as the 
“Automatically conform missing clips added to Media Pool” setting is enabled in the General 
Options panel of the Project Settings, DaVinci Resolve automatically tries to update the conformed 
relationship between clips you’re adding to the Media Pool and any clips in the various timelines 
of your project that have their Conform Lock Enabled setting turned off. This behavior is triggered 
whenever you add clips to the Media Pool by importing clips, copying and pasting clips, or 
creating duplicates of clips.

By default, each clip that’s part of an imported timeline, or that you’ve edited into a brand new 
timeline, has Conform Lock Enabled turned on by default (unless the source media goes missing). 
Conform Lock Enabled simply means that a particular clip in a timeline is set to only consider the 
source clip in the Media Pool to which it’s currently conformed as the correct match; all other 
clips in the Media Pool are ignored, even if there are multiple clips with the same file name and 
overlapping timecode that would make them also a valid match (such as when you have multiple 
copies of the same clip that in different formats, or multiple versions of VFX clips with the same 
name and timecode). 

If you right-click a clip with multiple potential matches in the Media Pool in the timeline and turn 
Conform Lock Enabled off, that clip will display a “clip conflict” error, with an attention badge to the 
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left of its name in the timeline. Double-clicking that badge reveals a dialog showing you every clip 
in the Media Pool with a matching file name or reel name and overlapping timecode, so that you 
can choose which Media Pool clip you want to conform that timeline clip to. 

NOTE: The “Auto conform clips with media added into Media Pool” setting must be 
disabled if you use collaborative workflow.

 — Using Conform Lock commands to force a timeline clip to conform itself to a clip 
in the Media Pool: A manual command for conforming a selected clip in the timeline with a 
selected clip in the Media Pool. Useful when none of the automated methods of conforming work, 
for whatever reason.

 — Using the Relink command on clips or bins in the Media Pool: If you have a DaVinci Resolve project 
in which there are unlinked clips in the Media Pool, that means the relationship between those clips 
and their corresponding source media files on disk have been lost. In this case, you can use the 
Relink Media, Relink Selected Clips, or Relink Clips in Selected Bins commands to relink clips to the 
corresponding source media on whatever storage volume it’s on. In the process, you’ll automatically 
relink any instances of those clips in all timelines in which they appear in that project. You can relink 
only unlinked clips by selecting them specifically, but you can also relink clips that are already linked if 
you want to force relink them to different media files (Relink Clips in Selected Bins relinks both unlinked 
and linked clips at once). The Relink command automatically searches all subdirectories within the 
currently selected directory, which is useful if you’re relinking to media that’s been moved to another 
location, and that may have a different directory structure as a result. However, a warning about 
searching large SAN volumes – you probably don’t want to use this command to choose a starting 
directory that’s too high up the file path, as the resulting search times may be unexpectedly long.

 — Using the Change Source Folder command: You also have the option to relink offline clips in the 
Media Pool using the Change Source Folder command, which changes the directory structure of each 
selected clip’s file path into a new file path based on a parent directory you select. This is mainly useful 
if you’re relinking clips to media that you’ve moved to another location, but that uses the same 
subdirectory structure as when the media was originally imported. For this reason, it’s a safe and 
fast command to use when relinking to a structured collection of media on a SAN volume.

 — Using the Reconform From Bin(s) command: If you’ve imported multiple versions of the same 
clips, with identical file names, overlapping timecode, or other matching criteria into separate bins 
of the Media Pool, you can turn off Conform Lock Enabled for every clip in a timeline you want to 
reconform, and then use the Reconform From Bin(s) command to reconform those timeline clips 
to Media Pool clips in one or more specific bins of your choosing. Reconform From Bin(s) also lets 
you choose the specific conform criteria you want to use to match clips in the timeline with clips 
in the selected bins. A key feature of this command is that DaVinci Resolve will only reconform 
timeline clips that are able to be matched to media in the bins you’ve selected; timeline clips for 
which no match can be found are left as they were before you used this command.

 — Using the Reconform From Media Storage command: This command lets you reconform 
timeline clips to clips in a selected directory in your file system that hasn’t been imported into 
the Media Pool first, and also lets you choose the specific conform criteria you want to use to 
match clips in the timeline with clips in the selected bins. A key feature of this command is that 
DaVinci Resolve will only reconform timeline clips that are able to be matched to media within the 
directory structure you’ve selected; timeline clips for which no match can be found are left as they 
were before you used this command.
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 — Overwriting clips on disk that are linked to in a DaVinci Resolve project: Last, but certainly 
not least, DaVinci Resolve is smart enough to automatically relink clips in the Media Pool that have 
been overwritten on disk by another version of the same file, so long as the file name, timecode, 
and reel name (if used) in the new version of the file still match.

The following sections illustrate each of these methods of conforming and relinking media 
in more detail.

Unlinking Clips
You can also choose to unlink clips in the Media Pool. To do so, select the clip or clips you 
want to unlink, right-click one of the selected clips, and choose Unlink Selected Clips from the 
contextual menu.

Conforming Clips During 
XML and AAF Import
For workflows where you’re importing AAF or XML projects, and relinking the resulting clips in 
DaVinci Resolve to media files that are either on disk, or conforming them to clips that are in the Media 
Pool already, the rules for how clip metadata is defined for reconforming depend on two settings 
in the Load AAF or XML dialog: “Automatically import source clips into media pool,” and “Ignore file 
extensions when matching.”

The most important settings for 
conforming media in the Load dialog

The ways in which these two checkboxes interact to let you choose how media is conformed to an 
imported AAF or XML file are complex, but here are the rules.

When Importing Clips With File Extensions Matching 
Those in the AAF or XML File

Turn “Automatically Import” on and “Ignore file extensions” off.

This is the default setting, and is most useful when the AAF or XML file you’re importing contains 
references to media you want to add to the Media Pool and use.
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 — First, if there are already clips in the Media Pool, DaVinci Resolve tries to conform as many of these 
clips as possible by matching the file paths in the AAF or XML file to the stored file paths of each 
clip in the Media Pool. 

 — Second, for all remaining clips not found, DaVinci Resolve imports as many clips as possible into 
the Media Pool from any storage volumes that are visible to DaVinci Resolve, using the file paths 
from the XML or AAF.

 — Third, for all remaining clips not found, DaVinci Resolve tries a clip name match of clips that are 
already in the Media Pool.

 — Fourth, for all remaining clips not found, DaVinci Resolve tries a timecode match (along with a reel 
name match if  this is enabled) of clips that are already in the Media Pool.

 — Finally, for all remaining clips not found, the user is prompted to manually choose 
another folder to search.

When Importing Clips With Different File Extensions

Turn “Automatically import” on and “Ignore file extensions” on.

Turning both of these options on is useful in situations where the sequence you’re importing was 
originally edited using offline quality media, and you want to conform to high-quality online media 
in a completely different format, possibly in the Media Pool, possibly on another disk. One example 
of this is as when the edit was done using QuickTime or Avid DNxHD media, but you’re reconforming 
to Blackmagic RAW files on another disk in order to grade the camera original raw media. Leaving 
“Automatically import source clips into media pool” on, in this case.

 — First, if there are already clips in the Media Pool, DaVinci Resolve tries to conform as many of 
these clips as possible by matching clip names. 

 — Second, for all remaining clips not found, the user is prompted to choose another folder 
to search, and DaVinci Resolve imports as many clips as possible by matching clip names, 
ignoring file extensions.

 — Third, for all remaining clips not found, DaVinci Resolve tries a timecode match (and reel name 
match if this is enabled in the General Options panel of the Project Settings) of clips that are 
already within the Media Pool.

 — Fourth, for all remaining clips not found, the user is prompted to manually choose 
another folder to search.

Turn “Automatically import” on and “Link to source camera files” on.

The “Link to source camera files” checkbox only appears when you import AAF files. Turning this 
option on when automatically importing media relinks the imported project to the original camera 
source files that are kept track of by Media Composer/Symphony via the “Source Name” metadata 
within the AAF file.

When You’re Only Relinking to Clips Already in the Media Pool

Turn “Automatically import” off.

Turning “Automatically Import source clips into media pool” off is useful in situations where you only 
want to conform the imported AAF or XML to clips in the Media Pool. This is most useful in situations 
where you’ve imported all of the camera original media into the Media Pool first, for example when 
creating the dailies that were then edited, and you want to conform the imported AAF or XML to the 
media that’s already there.
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 — First, if there are already clips in the Media Pool, DaVinci Resolve tries to conform as many of these 
clips as possible by matching the file paths in the XML or AAF to the file paths stored for each clip 
in the Media Pool. 

 — Second, for all remaining clips not found, DaVinci Resolve tries a clip name match of clips that are 
already in the Media Pool.

 — Third, for all remaining clips not found, DaVinci Resolve tries a timecode match (and reel 
name match if this is enabled) of clips that are already within the Media Pool. In this case, the 
file name is not used.

Beware When Choosing a Volume or Folder to Search
When prompted to choose a folder to search, you can optionally choose an entire volume; 
DaVinci Resolve always searches through all subdirectories, and eventually all media on that 
volume will be found. However, depending on the size and number of files on the selected 
volume, this operation could take an unexpectedly long time, especially on a SAN volume.

Importing Clips Before Importing 
an EDL, AAF, or XML
When you import media prior to importing an EDL, DaVinci Resolve follows a specific set of rules to 
determine which Media Pool clips correspond to clips in the resulting timeline. These rules also apply 
to situations where you’ve imported media prior to importing an AAF or XML file, in situations where 
you want to prioritize specific media over the file paths embedded in those imported timeline formats. 

The following sections go into detail on what these rules are, and how to use them to your advantage.

Essential Clip Metadata for 
Easy Conforming and Relinking
When conforming projects in DaVinci Resolve, the accuracy and integrity of clip metadata is critical for 
a successful result. Keep the following three criteria in mind when you’re preparing media to use in 
DaVinci Resolve.

 — Accurate timecode: Essential for every clip. First off, each clip should have a valid timecode 
track, and it should go without saying that the timecode should match the same timecode 
used by all other instances of that media file in a particular project. If there are problems with a 
clip’s timecode, DaVinci Resolve has tools you can use to edit or offset timecode to account for 
known inconsistencies. By default, the “Use Timecode” project setting is set to “Embedded in the 
Source Clip,” so that timecode is read from the embedded timecode track within a QuickTime or 
MXF file, or from the header data of a DPX frame file. However, you can also choose the “From the 
source clip frame count” option which enables timecode to be read from the Source clip’s frame 
count for image sequences.
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 — File names: When “Assist using Reel Names” in the General Options panel of the Project Settings 
is off (the default setting), this forces DaVinci Resolve to conform clips using file names when 
importing XML and AAF projects. File names can only be only used when conforming XML or AAF 
files, or when importing a DaVinci project; file names are never used when conforming EDLs.

 — Reel Name: Only used for conforming if “Assist using Reel Names” is on in the General 
Options panel of the Project Settings. Assigning reel names to your media is not essential, but 
recommended, and can make media management easier for certain operations, especially in EDL 
workflows. However, if you experience problems conforming clips with “Assist using Reel Names” 
turned on, you should try turning it off as one possible troubleshooting step.

How DaVinci Resolve matches media files to clips in an imported project depends on how you’re 
importing the project.

Defining Clip Metadata When Adding Media 
to the Media Pool
For workflows where you’re manually adding media files to the Media Pool when you’re editing from 
scratch in DaVinci Resolve, preparing to process dailies, or as a separate step before importing EDL, 
XML, or AAF project files and reconforming them to a higher quality set of media than what was 
originally used to edit with, the rules for how clip metadata is defined in preparation for conforming 
are a bit different.

 — Timecode: Calculated using the “Timeline Frame Rate” setting in the Master Project Settings 
panel of the Project Settings.

 — Reel Names: Determined depending on whether the “Assist using Reel Names from the” 
checkbox is on or off in the General Options panel of the Project Settings, and on which option 
you’ve selected. Reel names can be extracted dynamically, so any time you change this setting 
the reel names in the Media Pool update to reflect the change, or they can be defined manually, in 
which case you can set different clips to use different methods of reel name extraction.

 — Clip Names: Read and stored, used for AAF and XML imports, but not used for imported EDLs.

How Reel Names Are Identified
The “Assist using Reel Names” checkbox in the General Options panel of the Project Settings is an 
extremely important setting for controlling how the conform process works. By default, it’s turned 
off, and reel names are left blank. This is fine for conform workflows where all you need is the file 
path or file name and source timecode to successfully identify which media files correspond to what 
clips. However, if you need more information than that to reconform the clips in your project, you can 
turn on the “Assist using Reel Names” checkbox to enable DaVinci Resolve to use one of four different 
methods to automatically define reel names for every clip in the Media Pool.

Automatically Defining Reel Names
When you use the “Assist using Reel Names” options in the General Options panel of the Project 
Settings, reel names are extracted dynamically. This means that any time you change the method of 
reel name extraction in the Project Settings, the reel names of all clips in the Media Pool automatically 
update to reflect the change. This can be seen in the Reel Name column that’s visible if you put the 
Media Pool into List view. For example, were you to change the “Assist using reel names” options from 
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“Source clip file pathname” to “Mediapool folder name,” the contents of the Reel Name column would 
visibly change. This is useful when you’re importing a project for which all clips use the same method 
of determining their reel name.

Manually Choosing Reel Name Definitions for Individual Clips
You also have the option of manually choosing the criteria for how one or more selected clips in the 
Media Pool have their reel names defined, using the Clip Attributes dialog. This is useful when there 
are certain clips in a project that need to use a different method of reel name extraction, or manually 
entered reel names.

To manually define reel names for one or more clips:

1 Select one or more clips in the Media Pool.

2 Right-click one of the selected clips, and choose Clip Attributes from the contextual menu.

3 Open the Reel Name panel of the Clip Attributes dialog, choose a new option, and click OK.

Once you’ve used Clip Attributes to change the reel names of clips, those clips no longer automatically 
update when you change the “Assist using Reel Names” options in the General Options panel of the 
Project Settings. For more information on using Clip Attributes, see Chapter 19, “Using Clip Metadata.”

Methods of Defining Reel Names
There are five options that are available for automatically determining how reel names are extracted 
from the source media when “Assist using Reel Names” is turned on, and one option in the Clip 
Attributes Reel Name panel for manually defining reel names. The use of reel names is critical in EDL 
and AAF workflows, but isn’t necessarily as important in XML-centric workflows.

 — Source clip file pathname: Obtains the reel name by extracting it from each media file’s path. 
This makes it possible to extract a reel name from all or part of the file name, or from all or part 
of the name of any folder in the path that encloses that file. This extraction is defined using the 
Pattern field.

 — Pattern: A code that defines how a reel name should be extracted from the source clip pathname. 
More information about creating patterns appears later in this chapter.

 — Media Pool folder name: The reel name is obtained from the name of the bin in the Media Pool 
that encloses that clip. For example, in a stereoscopic workflow you might want to export offline 
stereo media with the “Left” and “Right” bin names in which they’re organized as reel names. 
Another example would be organizing VFX being incrementally processed in individually named 
bins, such as “VFX_Tuesday_10-12.”

 — Embedding in Source clip file: Useful for file formats where the reel name is embedded within 
the media file itself. Blackmagic RAW and other digital cinema cameras, QuickTime files created by 
Final Cut Pro, and DPX frame files are formats that can contain reel name header data.

 — Source clip filename: If there is no defined reel number, often it’s easy to just use the 
Source clip filename.

 — User Defined: This option is only available when you manually alter the Reel Name for one or 
more selected clips in the Media Pool using the Clip Attributes dialog. Choosing User Defined lets 
you type any string of text you like to use as the reel name.
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An additional checkbox is available, “Extract reel names from EDL comments,” which is primarily useful 
for legacy workflows in which you conform an EDL exported from Final Cut Pro 7 to camera original 
R3D media.

 — Extract reel names from EDL comments: Some media file formats, such as R3D, have reel 
names, obtained from the file names, that are longer than the eight characters that are allowable 
in a standard EDL. This option allows DaVinci Resolve to extract reel names from appropriately 
formatted EDL comments, such as those output from Final Cut Pro 7.

Using the Pattern Field
If you’re using the Pattern option to extract the reel name from a clip’s source file pathname, you have 
the option to create your own search pattern, enabling you to have DaVinci Resolve extract the reel 
name in highly specific ways to accommodate more exotic workflows. 

Extraction patterns are interpreted from right to left, deciphering each clip’s file path element by 
element starting with the file name, and then considering each enclosing directory’s name to the left. 
Each extraction pattern consists of a series of text characters and “wild card” operators in unique 
combinations corresponding to the length and names used in the file path.

Here are a series of search characters that may be used.

Extraction Pattern Operators

?
Looks for matches of any single character. Add as many question marks as there are 
characters you want to match. ?? matches two characters such as 02; ???? matches four 
characters such as 0002.

* A wildcard that creates matches for any sequence of zero or more characters.

%R
Specifies the reel name’s actual location. Reel names may contain any character, but should 
not contain a directory separator (forward slash). 

%_R
Extracts the reel name and strips out the R3D file name underscores found in EDLs from 
Final Cut Pro 7 or earlier.

%D
Matches any directory name or file name. When this is the last operator in a pattern, do not 
add a forward slash.

/ Used to separate any two operators

If you’re trying to create a new extraction pattern for a unique workflow, there’s a test dialog you can 
use to try different patterns out before applying them to your project.

To test the extraction path:

1 Turn on “Assist using reel names from the” and click the Test button next to the current Pattern 
in the General Options panel of the Project Settings. The “Specify Reel Extraction Pattern” 
dialog opens.

2 Type the extraction patten you want to test into the Pattern field. 

3 Using whatever method you prefer, find the file path of the media file that you want to test the 
extraction pattern on, and copy or type it into the Sample Path field. 
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4 Click Test. 

5 If the reel name that appears below is correct, then click Apply to copy the extraction pattern 
into the Pattern field of the General Options panel of the Project Settings. If the reel name that 
appears is not correct, modify the extraction pattern and try again.

Examples of Reel Name Extraction Patterns
To better understand how this process works, below are several examples showing the various 
methods of reel name extractions. The / is used as the separator between control parameters.

Example 1: 

This example shows the reel name stored within the parent folder name of the clip.

 — Pattern: */%R/%D

 — File path: vol0/MyMovie/Scans/004B/Frame[1000-2000].dpx

 — Reel name: 004B

Parsing takes place from right to left so to analyze this pattern start at the right end. In this case 
the %D matches to the file name “FrameNNNN.dpx” where NNNN is the frame number in each file 
of the clip. Moving left of the file name, the /%R/ section of the string is next. This specifies that 
the reel name will be the entire name of the parent directory immediately above the file. Then the 
* at the beginning of the string says match any pathname in front of the directory name that has 
the reel name. This string would find the parent directory regardless of how many levels deep it is 
nested on the directory path.

Example 2: 

Here we see the reel name stored in the parent folder name of the clip and prefixed with the 
reel name.

 — Pattern: */????%R/%D or alternatively */Reel%R/%D

 — File path: /vol0/MyMovie/Scans/Reel1234/Frame[1000-2000].dpx

 — Reel name: 1234

In this example both of these extraction patterns produce the same result. They are also similar to 
the first example. The reel name is still in the parent directory name but in this case it will have the 
fixed characters “Reel” prefixed in front of the reel name. The first pattern with ???? would actually 
match with any 4 characters in front of the reel name. The second pattern is more specific and 
would only match the word “Reel” in the directory name.

Example 3: 

This example shows the reel name stored within the parent folder name two directory levels up.

 — Pattern: */%R/%D/%D

 — File path: /vol0/MyMovie/Scans/004B/134500-135000/Frame[1000-2000].dpx

 — Reel name: 004B

This example is again similar to Example 1. The difference is that in Example 3, the reel name is the 
directory name two levels above the clip. In Example 1, the reel name was in the directory name 
only one level up.
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Example 4: 

Finally, we see the reel name that is embedded within the clip name of the material.

 — Pattern: */Reel%R_*

 — File path: /vol0/MyMovie/Scans/Reel004B_[1000-2000].dpx

 — Reel name: 004B

This example shows a method for extracting the reel name from the file name of the clip. Again, 
starting at the right the two pattern characters “_*” match any series of characters up to the first 
underscore character. In this case it will pick up the file extension (.dpx) and the frame number 
portion of the file name. Next, the “/Reel%R” characters indicate the reel name is the characters 
between the “/Reel” and _ character. The * at the beginning of the pattern will match a file path 
any number of directories deep in front of the file name.

Conform Missing Clips by 
Importing Their Source Media
If you have a timeline with one or more missing clips, that means that the relationship between that 
clip in the timeline and the Media Pool has been lost because there is no corresponding clip in the 
Media Pool. If you decide to manually import clips into the Media Pool that correspond to missing 
clips, the “Automatically conform missing clips added to Media Pool” checkbox in the General Options 
panel of the Project Settings determines what happens. Please note, the “Auto conform clips with 
media added into Media Pool” setting must be disabled if you use collaborative workflow.

As long as the “Auto conform clips with media added into Media Pool” setting is enabled in the 
General Options panel of the Project Settings, DaVinci Resolve automatically updates the conformed 
relationship between clips that you add to the Media Pool and missing clips in the various timelines 
of your project. DaVinci Resolve also updates the conform relationship of all other timeline clips that 
have Conform Lock Enabled turned off at this time as well. All of this is done at the time you import 
the clips.

However, if “Auto conform clips with media added into Media Pool” is turned off when you import 
additional clips into the Media Pool, then DaVinci Resolve will not attempt to reconform anything 
automatically, instead relying on you to reconform offline or missing clips manually using one of the 
many methods of manual reconforming that are available such as Reconform From Bins or Conform 
Lock With Media Pool Clip.

For more information about manually adding clips to the Media Pool, see Chapter 18, “Adding and 
Organizing Media with the Media Pool.”
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Using the Import Additional 
Clips Command
If you find that there are a lot of missing clips in a timeline that have no corresponding Media Pool 
clips, there’s an easy way to fix this, that automates the process of gathering a list of what’s missing so 
as to import all missing clips and conform them at once. This only works for missing clips, it does not 
work for unlinked clips (for which you should use the Relink command in the Media Pool).

Conformed Timeline showing missing clips

To import missing clips and reconform them to the Timeline:

1 In the Edit page, right-click a timeline in the Media Pool that has missing clips, and choose one of 
the following commands from the Timelines > Import submenu:

 — Timelines > Import > Additional Clips With Loose Filename Match: Searches the Timeline 
for all missing clips, and prompts you to specify a directory of media with which to attempt 
to conform them, adding only the media that’s necessary to the Media Pool. The “Loose 
Filename Match” command ignores file extensions, which lets you replace offline media with 
online media in a different format.

 — Timelines > Import > Additional Clips With Tight Filename Match: Searches the Timeline 
for all missing clips, and prompts you to specify a directory of media with which to attempt 
to conform them, adding only the media that’s necessary to the Media Pool. The “Tight 
Filename Match” command searches only for media with identical file extensions.

2 Choose the directory with the remaining media to be conformed in the dialog that appears, 
and click OK.

If the conditions are met for matching the media files in the directory you selected to the missing 
clips in the current Timeline, then the necessary clips are automatically added to the Media Pool 
and conformed to the timeline.
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Using Conform Lock As a Command
If, for whatever reason, an unlinked clip in a timeline simply won’t conform to a clip in the Media Pool, 
even when you know it’s there, you can use the “Conform Lock with Media Pool Clip” command to 
force a clip in the Timeline to conform to a clip in the Media Pool of your choosing. 

This command automatically suspends the Conform Lock Enabled setting of a target clip and ignores 
file names and reel names in favor of conforming the target clip to another clip that you’ve manually 
selected, while timecode is still used to align the clip being conformed with the clip that was in the 
Timeline originally.

To conform lock a clip in the Timeline to another clip in the Media Pool:

1 Select a clip in the Media Pool. The clip you select in the Media Pool must be equal in length or 
longer than the clip you select in the Timeline for Force Reconform to work.

2 Right-click an unconformed clip in the Timeline, and choose “Conform Lock with Media Pool Clip” 
from the contextual menu. The selected clip in the Timeline is conformed to the clip you selected 
in the Media Pool in one of two ways:

 — If the selected Media Pool clip has timecode matching the selected Timeline clip: The 
new clip is perfectly conformed to match the original clip.

 — If the selected Media Pool clip doesn’t have timecode matching the selected Timeline 
clip: The new clip is conformed such that the first frame of the Media Pool clip is aligned with 
the first frame of the reconformed clip in the Timeline, and occupies the same duration.

3 If you right-click that clip again, you’ll see that Conform Lock Enabled is enabled, showing you that 
the clip has been conform locked to media for which it wasn’t originally a match.

Relinking Clips to Media Files on Disk
The easiest and best known method of relinking clips in your project that have either gone offline or 
are not linked to the correct set of media files on disk is to use the appropriately named “Relink Media” 
or “Relink selected clips” command. Note, the Relink command will only work for clips that are unlinked, 
it will not work for clips that are missing and so have no corresponding clips in the Media Pool. 

The Relink command is the most flexible method of relinking clips in the Media Pool of your project 
with clips in a file system directory of your choice, using file name and timecode as the primary criteria 
for re-creating the correspondence between each clip and its corresponding media file on disk. This is 
a good command to use to relink media that’s been moved to another location or reorganized using 
another file structure on disk.

To relink all unlinked media:

1 Select the orange Relink icon in the page’s Media Pool.

2 Select the Locate button next to the specific volume(s) that are missing, and choose a directory 
where the missing files are now

3 If the quick search initiated by the Locate buttons doesn’t find media that you know is there, you 
can initialize an exhaustive deep disk search for the media by clicking on the Disk Search button.

4 If there are still other clips that couldn’t be found, you’re prompted to either choose another 
directory altogether to continue searching, or quit.
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To relink selected clips:

1 Select one or more offline clips to relink, or select a bin in the Media Pool bin list that contains 
clips you want to relink, then right-click one of the selected clips or the selected bin, and choose 
“Relink Selected Clips” from the contextual menu.

2 When the Relink File dialog opens, choose a directory in which to look for the files you want to 
relink to, and click OK. DaVinci Resolve attempts to find every clip with a matching file name in the 
subdirectories of the directory you chose, using the original file paths of the clips being relinked to 
do this as quickly as possible. By first looking for the clips in the directories they were originally in, 
relinking can be quite fast.

3 If there are any clips that couldn’t be found using the method in step 2, you’re prompted with 
the option to do a “deep search” by a second dialog. If you click Yes, then DaVinci Resolve will 
look for each clip inside every subdirectory of the directory you selected in step 2. This may take 
significantly longer, but should be completely successful so long as the media that’s required is 
within the selected directory structure.

4 If there are still other clips that couldn’t be found, you’re prompted to either choose another 
directory altogether to continue searching, or quit.

Using “Change Source Folder” 
to Relink Clips
If you’ve used your file system to move media that’s associated with a DaVinci Resolve project, but you 
haven’t changed the directory structure with which it’s organized, you can use the “Change Source 
Folder” command to quickly relink selected clips in the Media Pool to the new file path of the media 
on disk, using the original file paths as a guide. This is a good relinking method to use, if possible, for 
projects on a SAN where you don’t want to risk the excessively long search times that could result 
from using the Relink command to examine a nested hierarchy of folders in a more flexible way.

To relink your Media Pool clips to a new location:

1 Select one or more clips in the Media Pool, then right-click one of the selected clips, and choose 
“Change Source Folder” from the contextual menu. The Relink Media window appears displaying 
the original path for the material, with controls for choosing a new directory.

2 Click the “Browse” button to the right of the “Change To” field, and then use the file navigation 
dialog to find the new location of the media file, select it, and click Open.

3 If you succeeded in finding the appropriate media file, click Change. Otherwise, click Cancel.

Using the “Reconform From Bins” 
Command
The “Reconform From Bins” command gives you a way of reconforming multiple clips in a timeline at 
once to a specific bin (or bins) of clips with matching metadata. To use this command, you must first 
select the clips you want to reconform in a timeline (you can choose all of them or just a subset) and 
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turn off Conform Lock Enabled, and then, using the Reconform From Bin command, you can manually 
choose another bin of clips in the Media Pool that you want to reconform to.

An important aspect of the Reconform From Bins command is that DaVinci Resolve only reconforms 
timeline clips that can be matched to source clips in selected Media Pool bins. All timeline clips 
that cannot be matched are left alone. This makes Reconform From Bins an ideal command to use 
when you’ve imported a subset of clips to the Media Pool that you need to reconform to clips found 
throughout an existing timeline. 

For example, you could use this method to:

 — Replace transcoded versions of clips in a timeline with the original camera raw clips.

 — Replace the previous versions of VFX clips in a timeline with new versions.

 — Replace the offline-quality media you’ve been working with so far with online-quality media.

 — Replace the temp clips you were originally given with rescanned or recaptured stock footage.

To use Reconform From Bins, it’s important to organize the clips you’re adding to the Media Pool 
sensibly, in a self-contained bin or bins separate from the other media used by that timeline. It can be 
a sub-bin, but it must be separate. 

Here’s a simple example. If the media you edited or originally imported is in Bin 1, then import the 
updated versions of all clips that need to be reconformed into Bin 2. Using Reconform From Bins, 
you can then decide whether the clips in your timeline should be conformed to Bin 1, or Bin 2 when 
possible, because only timeline clips for which there is a valid match are reconformed, while all other 
timeline clips are ignored. 

DaVinci Resolve has the ability to choose custom conform options to control what metadata is used 
to match timeline clips to source clips in the Media Pool. This means that you’re not restricted to only 
using Timecode, Reel Name, and File Name, you could also use any combination of Total Duration, 
Resolution, Bit Depth, Frame Rate, File Format, Codec, and/or Media UMID/UID to control how clips are 
conformed, depending on your needs and the problem you have to solve. 

The Reconform from Bins dialog
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However, if the criteria you’ve selected to control the conform doesn’t match, the Reconform From 
Bins operation will fail, and you’ll need to either try again with other conform criteria, or manually 
replace the necessary clips in the Timeline.

Here’s a step by step workflow.

To reconform a timeline to clips within a specific Media Pool bin:

1 Double-click the Timeline you want to reconform to open it.

2 Either select the specific clips you want to reconform, or press Command-A to select every clip in 
the Timeline if you want to reconform clips throughout the entire timeline without having to make 
individual selections.

3 Right-click one of the selected clips, and choose “Conform Lock Enabled” to disable Conform Lock 
Enabled for the clips you want to reconform. This frees DaVinci Resolve to consider all possible 
conform matches for those clips in cases where there may be multiple clips with overlapping 
timecode in the Media Pool.

4 Right-click the current Timeline in the Media Pool, and choose Timelines > Reconform From Bins. 
The Conform Options dialog appears, with Timeline Options and Choose Conform Bins list to the 
left, and the Conform Options panel to the right.

5 From the Timeline Options section, choose whether you want to conform to All Clips or just 
to Selected Clips. Then, choose whether you want to “Set clips to Conform Lock Enabled” 
after conform.

Choosing which clips in the Timeline to attempt to reconform

6 In the Choose Conform Bins section, click the disclosure triangle to the left of the Master bin to 
reveal the sub-bins contained within.

7 Turn on the checkboxes for the bins with media you want to conform the Timeline to, and turn off 
the checkboxes for bins with media that you want to ignore. 

Selecting folders for reconform
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8 Next, choose the conform options you want to be considered when matching timeline clips 
to Media Pool clips in the selected bins. By default, Timecode is enabled. Choose additional 
criteria to be even more selective about how you want clips to be reconformed, or choose 
different criteria if you need to use other metadata to get better results for clips you’re having a 
hard time conforming.

Selecting criteria to guide the reconform

TIP: Choosing Custom from the top of the pop-up menu for File Extensions, File 
Format, and Codec displays editable fields into which you can enter multiple options, 
separated by commas, in order to list multiple possibilities for a successful match. The 
order in which you enter these is important, as DaVinci Resolve will attempt to conform 
clips starting with the first format/codec at the left, moving to try the next format/
codec to the right if no match is found, until every entry in your list has been tried.

9 Click OK. Where possible, the Timeline is automatically updated to conform to the media 
contained within the bins you checked.

10 After you’ve used “Reconform From Bins,” any timeline clips that have been reconformed and 
that now have timecode and reel names/file names that match two or more source clips in the 
Media Pool will display a clip conflict badge in the Timeline. To eliminate this badge, you can select 
either just the clips that were conformed, or all clips in the Timeline, right-click them, and choose 
Conform Lock Enabled to eliminate these warnings.
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Using Reconform From 
Media Storage
DaVinci Resolve 14 introduces another reconform method, that lets you conform clips in a timeline 
to clips in a specific File System directory (including all subdirectories) using the “Reconform From 
Media Storage Folders” command. This allows you to reconform multiple clips in a timeline, all at 
once, to matching source media files on disk without having to import those clips to the Media Pool 
first; all clips that can be conformed according to the specified conform criteria will be automatically 
imported as necessary.

An important aspect of the Reconform From Media Storage command is that DaVinci Resolve will 
reconform all timeline clips that can be matched to source media files on disk in the selected Media 
Storage directories, but all Timeline clips that cannot be matched are left alone. This makes Reconform 
From Media Storage an ideal command to use in the following situations:

 — When you need to reconform clips that are found throughout an existing timeline to a smaller 
subset of media in a specific directory on disk, such as updated VFX or Motion Graphics from a 
third-party application. 

 — When you need to quickly reconform missing timeline clips throughout an imported timeline, 
and especially when you need to use custom conform criteria to successfully reconform those 
clips. (Unlinked clips can only be reconformed with this command if you select them and turn off 
Conform Lock Enabled first.)

Similar to the Reconform From Bins command, you can specify exactly what combination of conform 
criteria you want to use to match clips in the timeline with clips in the Media Pool. This means that 
you’re not restricted to only using Timecode, Reel Name, and File Name, you could also use any 
combination of Total Duration, Resolution, Bit Depth, Frame Rate, File Format, Codec, and/or Media 
UMID/UID to control how clips are conformed, depending on your needs and the problem you 
have to solve.

The Reconform From Media Storage dialog
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This method of timeline conform is ideal when the only way you can conform a timeline to the media 
you require is using a very specific combination of metadata that’s different from the rules that 
DaVinci Resolve defaults to. 

For example, you have a jumbled mix of 8- and 10-bit versions of the same clips on your hard drive, 
but you only want to conform a given timeline to the 10-bit media in preparation for finishing. Using 
“Reconform from media storage folders” lets you be this specific with what media to use.

To use “Reconform from media storage folders” to reconform a timeline:

1 Double-click the Timeline you want to reconform to open it.

2 Either select the specific clips you want to reconform, or press Command-A to select every clip in 
the Timeline if you want to reconform clips throughout the entire timeline without having to make 
individual selections.

3 Right-click one of the selected clips, and choose “Conform Lock Enabled” to disable Conform Lock 
Enabled for the clips you want to reconform. This frees DaVinci Resolve to consider all possible 
conform matches for those clips in cases where there may be multiple clips with overlapping 
timecode in the Media Pool.

4 Right-click the timeline you want to reconform, and choose Timelines > Reconform from media 
storage folders. The Import From dialog appears, with a File System browser to the left, and an 
Options panel to the right.

5 From the Timeline Options section, choose whether you want to conform to All Clips or just 
to Selected Clips. Then, choose whether you want to “Set clips to Conform Lock Enabled” 
after conform.

Choosing which clips in the Timeline to attempt to reconform

6 From the Conform Folders section, choose a directory that contains media 
you want to reconform to. 

Selecting a directory that has media you want to conform to

7 Next, choose the conform options you want to be considered when matching timeline clips to 
source media files in the selected directory. By default, Timecode is enabled. Choose additional 
criteria to be even more selective about which clips will be reconformed, or choose different 
criteria if you need to use other metadata to get better results.
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Selecting criteria to guide the reconform

TIP: Choosing Custom from the top of the pop-up menu for File Extensions, File 
Format, and Codec displays editable fields into which you can enter multiple options, 
separated by commas, in order to list multiple possibilities for a successful match. The 
order in which you enter these is important, as DaVinci Resolve will attempt to conform 
clips starting with the first format/codec at the left, moving to try the next format/
codec to the right if no match is found, until every entry in your list has been tried.

8 Click OK. Where possible, the Timeline is automatically updated to conform to the media in the 
directory you selected, and all source media files that were conformed have been imported into 
the Media Pool.

9 After you’ve used “Reconform From Media Storage Folders,” any timeline clips that have been 
reconformed and that now have timecode and reel names/file names that match two or more 
source clips in the Media Pool will display a clip conflict badge in the Timeline. To eliminate this 
badge, you can select either just the clips that were conformed, or all clips in the Timeline, right-
click them, and choose Conform Lock Enabled to eliminate these warnings.
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Understanding, Fixing, and 
Using Reel Conflicts
As long as the “Auto conform clips with media added into Media Pool” setting is enabled in the General 
Options panel of the Project Settings, the same dynamic relationship between clips in the Media Pool 
and those in a timeline are maintained whether clips are linked or unlinked, it makes no difference. 
However, this does mean that if you have two different versions of the same clip in the Media Pool, 
or even two completely different clips that share the same file name (or reel name) and the same 
overlapping timecode, then DaVinci Resolve is capable of automatically conforming to either clip. 

A good example of this is if you have both the camera raw version of a clip, and a ProRes or MXF 
transcoded version imported into the Media Pool at the same time. Both clips have the same content, 
the same file name, and the same range of frames. This poses the potential for what DaVinci Resolve 
refers to as a “clip conflict.”

You won’t necessarily notice this at first because, by default, all clips that are imported with a timeline, 
or that you’ve edited into a brand new timeline, have a Conform Lock Enabled setting enabled by 
default. All clips in a timeline with Conform Lock Enabled turned on only consider the current clip 
in the Media Pool to which they’re conformed as the valid clip; all other clips with file names and 
overlapping timecode that would otherwise make them an otherwise valid match are ignored. 

However, if you right-click such a clip in the Timeline and turn Conform Lock Enabled off, that clip will 
display a “clip conflict” error, with an “attention” badge to the left of its name in the Timeline.

Conflict icon indicating at least two clips 
have matching conform parameters

Clip conflicts are typically considered to be an error, but not always. They can be a problem if the 
media you’ve imported along with an imported project from another application has media that was 
added with timecode but no reel identifier (for example, when shots from multiple unidentified reels 
that all start at 0 hour). The thing is, you may not immediately notice such clip conflicts, until you turn 
Conform Lock Enabled off.

TIP: Overlapping timecode often occurs in the normal course of work, but should 
be managed by altering each clip’s embedded reel name, or by organizing media in 
different bins.
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Using Clip Conflicts as a Conform Tool
On the other hand, clip conflicts can often be desirable solutions to workflows where you need 
to switch among different versions of a particular clip. To take the example of an edited timeline 
consisting of transcoded QuickTime versions of camera raw original media, if you only had the 
transcoded clips in the Media Pool, then all is well. 

However, suppose in the course of working that you decide you need the resolution or additional color 
latitude of the camera raw version of a particular clip. If you import the camera raw version of that 
one clip, you should notice nothing different. However, if you then right-click that clip in the Timeline 
and choose Conform Lock Enabled to uncheck the setting and turn it off, you should then see the 
attention badge to the left of the clip name in the Timeline. This lets you know that this clip in the 
Timeline is correctly seeing the relationship between it and the now two simultaneously named clips 
with timecode overlap in the Media Pool.

The current relationship between this timeline clip and the one to which it is conformed doesn’t 
change; this badge is only letting you know that now there is a second clip in the Media Pool to which 
you could potentially conform this clip in the Timeline. Now, you need only choose which one by 
double-clicking the clip conflict badge, and following the procedure below.

Resolving Clip Conflicts
Once you have a clip conflict, whether intentional or not, it’s really easy to resolve it. In fact, this 
feature is the very basis for the name of the software.

To resolve a reel conflict by relinking a clip’s media:

1 Double-click the “attention” badge of any clip in the Timeline, displayed to the left of that clip’s name.

The Conflict Resolution window appears, showing a list of all files in the Media Pool, of any format, 
that have identical file names (or reel names) and timecode that overlaps with the clip you right-
clicked. Each item in this list shows a thumbnail of the clip, the file path of the media on disk, the 
file name, starting timecode, reel name (if any), and creation date, to help you determine which of 
the clips in that list is the one you want to use.

Conflict Resolution window showing what other clips 
have overlapping timecode and reel information

1094Import and Conform Projects | Chapter 56 Conforming and Relinking Clips



2 Click the entry in the list that you want to conform to, and click Apply. The clip in the Timeline 
changes to reflect the media you selected, and the “attention” icon is replaced with a “resolved” 
badge indicating that the conflict has been resolved. Keep in mind that you can always double-
click the “resolved” badge to change which Media Pool clip you want to conform to. It remains a 
dynamic relationship.

A clip badge showing that the conflict was resolved

Re-editing Media Directly 
to the Timeline
If, for whatever reason, none of the above methods of relinking or reconforming have worked, 
sometimes the only thing left to do is to replace the problem clip in your timeline with a different clip. 
For example, you may need to replace an old version of an effects shot with a newer one, or or you 
need to replace an offline version of a stock footage shot with a higher quality one, and the problem 
is that you’ve got a mismatched filename and/or timecode, no reel name, and the files are completely 
different formats, frame sizes, and durations. 

In this case, it’s a good thing that DaVinci Resolve has such good editing tools. For more information 
on editing, see Chapters 34 through 47. When fixing conform problems via manual editing, the 
replace edit is your special friend. For example, you could use a replace edit to match a new incoming 
clip’s timing to the old one. Or you could use a three-point edit, a place on top edit, or even a simple 
drag and drop edit to put the new clip into the Timeline to take the place of the old one. For specific 
information on the different edit types in DaVinci Resolve, see Chapter 36, “Editing Basics.”
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How Grades Are Linked 
to Multiple Timelines
If you’ve set your project up to use Remote versions, then any clips that refer to the same file in 
the Media Pool are linked and share the same Remote versions of grades that are applied to them. 
For example, two clips that are close-ups from the same take refer to the same media file, so they’re 
both automatically linked to one another and share the same remote grades. 

Clips using Remote versions also exhibit this behavior when they appear in multiple timelines. 
Clips using Remote versions that are located in different timelines, but that refer to the same file in 
the Media Pool, are linked and share the same remote versions of grades. This is why you can grade 
one timeline, and then import a re-edited version via EDL, AAF, or XML, and have the new timeline 
automatically inherit all grades from the previous timeline.

However, you can override this behavior to have one timeline that’s independently graded from the 
others. Simply select that timeline, open the Color page, right-click any clip in the Thumbnail timeline, 
and choose Copy Remote Grades to Local from the contextual menu. All grades are copied to Local 
versions, and from that point on all changes you make to grades in that timeline have no effect on the 
other timelines in your project. 

For more information about Local and Remote versions, see Chapter 139, “Grade Management.”
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Chapter 57

Creating Digital 
Dailies for Round 
Trip Workflows
DaVinci Resolve can be used to create media for editors to use in 
other applications in situations where those applications are unable 
to import a given project format but DaVinci Resolve can. 

In the process, you can use DaVinci Resolve’s many organizational, effects, and grading capabilities to 
create media that’s a pleasure to edit with, normalizing log-encoded media, syncing dual-source audio 
in a variety of ways, and doing some fast (or not-so-fast) grading to make sure that the media being 
edited looks its best.

Furthermore, once you’ve created a project to accomplish these tasks, you’ve also given yourself a 
jump-start on reconforming the project should your workflow be to move the edited project back into 
DaVinci Resolve for editing and finishing. This chapter covers a workflow for importing, preparing, and 
outputting media for these situations.
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Step 1–Ingest Media and Add/Edit Metadata
It’s not necessary to have a project file exported from an NLE to start working in DaVinci Resolve. 
Using the Media Storage browser on the Media page, you can access any volume that’s currently 
available to the system, and import any compatible media format into the Media Pool.

Media Storage browser with scrubbable clip thumbnails

The Media Pool is DaVinci Resolve’s internal project library of available media for the currently open 
project. If you like, clips in the Media Pool can be organized into multiple bins. Once media has been 
added to the Media Pool, you can access a variety of descriptive metadata using the Metadata Editor, 
adding descriptions, notes, scene and take information, flags, day and date information, program and 
episode information, and so on. This data can populate metadata tags when exporting ALE lists to 
move the metadata to a compatible NLE.

For more information on ingesting media in the Media page, see Chapter 18, “Adding and Organizing 
Media with the Media Pool.”

The Media Pool
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Step 2–Sync Audio to the Dailies
If your video format has embedded audio, DaVinci Resolve can simply pass that audio through when 
outputting media from the Deliver page. However, if the program you’re working on employs dual-
system audio recording, there are a variety of methods available for syncing it in the Media page. You 
can also import timecoded Broadcast WAVE files into the same bin as the accompanying video clips 
(you can place them into a sub-bin if you like), in preparation for syncing the dailies in DaVinci Resolve. 
Once you’ve imported the video and audio media you want to sync into the Media Pool of the Media 
page, you can right-click the enclosing folder and choose “Auto-Sync Audio Based on Timecode” which 
automatically syncs every timecode-matched pair of audio and video media clips within the same 
folder, all at once. Alternately, you can choose “Auto-Sync Audio Based on Timecode and Append 
Tracks” to add the synced audio tracks to any audio tracks already present in the video clips.

TIP: For the best results, consider using different folders for each day’s audio and 
video clips.

If you don’t have synced timecode, but your video clips have separately recorded audio (usually via 
an on-camera microphone) that matches the dual-system audio recordings, you can use waveform 
syncing to quickly sync each video clip with its matching audio clip. Import your separately recorded 
audio files into the same bin as the accompanying video clips (you can place them into a sub-bin if you 
like), in preparation for syncing. Once imported, you can right-click the enclosing folder and choose 
“Auto-Sync Audio Based on Waveform” which automatically syncs every timecode-matched pair of 
audio and video media clips within the same folder, all at once. Alternately, you can choose “Auto-Sync 
Audio Based on Waveform and Append Tracks” to add the synced audio tracks to any audio tracks 
already present in the video clips.

TIP: With waveform syncing, for the best and fastest results, consider using different 
folders for each day’s audio and video clips, or even different folders for each scene, to 
reduce the number of waveforms that need to be compared at one time.

Finally, if all you have in the way of sync reference is a humble clapboard, you can manually sync video 
and audio clips by selecting a video clip to open into the Media page viewer, and then clicking the 
Waveform button in the Audio panel and clicking the corresponding audio clip to show its waveform 
in the audio panel. In this way, you can drag the Viewer and Audio panel’s playheads to the video and 
audio sync points, and click the Audio panel’s link button to lock the A/V sync of that clip.

For more information on syncing audio and video in the Edit page, see Chapter 22, “Modifying Clips and 
Clip Attributes.”
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Step 3–Do Whatever Grading is Necessary
Many productions that decide not to record camera raw media instead elect to record a log-encoded 
or “flat” image to ProRes or DNxHD media files in order to preserve the most image data for grading 
without clipping highlights or shadows. This can be accomplished using in-camera settings that 
record log-encoded QuickTime or MXF media, or via external video recorders such as the Blackmagic 
Video Assist. Depending on the camera you’re shooting with, the recorded media will use one of a 
variety of log-encoded gamma curves such as Log-C, S-Log, S-Log2, S-Log3, BMD Film, CanonLog, 
Panasonic VLog, or REDlog Film, among others.

In other workflows, raw video formats are recorded and later debayered as log-encoded clips in order 
to preserve the maximum amount of debayered data for grading, or in preparation for transcoding.

If you’re outputting high-quality media files meant to be used themselves for later finishing, then you 
may want to simply pass the source image data through unaltered. However, if you’re creating offline 
media for editors, directors, and producers to watch for the next three months, you can grade this 
data in a variety of ways to provide more pleasing output that’s been “normalized” in order to look 
closer to what was monitored on-set during the shoot.

There are many ways of normalizing log-encoded media in DaVinci Resolve. If you’re working with one 
or more raw formats, you can choose to debayer all clips straight to Rec. 709 in the Camera Raw panel 
of the Project Settings. However, if you’re working with log-encoded ProRes or DNxHD media, you 
need to normalize these clips using other methods.

An easy and powerful way to do so is to use DaVinci Resolve Color Management. To do so, set the 
“Color science” setting within the Color Management panel of the Project Settings to “DaVinci YRGB 
Color Managed.” Then, right-click each clip or group of clips in the Media Pool, and choose the 
appropriate setting for each type of media from the Input Color Space submenu (you can define the 
Input Color Space of multiple selected clips at once). For more information on using DaVinci color 
management, see Chapter 9, “Data Levels, Color Management, and ACES.”

Enabling DaVinci Resolve color management
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If you don’t want to use DaVinci color management, you can also use one or more LUTs (Lookup 
Tables) to  normalize log-encoded media. You can apply a LUT to the entire project to normalize the 
particular log characteristics of the media you’re processing. Project-wide LUTs can be applied in the 
Color Management panel of the Project Settings. For more information, see Chapter 4, “System and 
User Preferences.”

Project-wide LUT table settings on the Lookup Tables panel of the Project Settings

In the case of LUT-managed shooting workflows where a variety of LUTs have been custom-designed 
to monitor different scenes, you can manually apply individual LUTs to one or more selected clips from 
each scene using the Media Pool’s contextual menu. 

You can also edit each scene’s clips into timelines, and apply separate LUTs to each clip in the 
Clip mode of the Node Editor of the Color page, or apply a single LUT to an entire timeline using the 
Timeline mode of the Node Editor. For more information on using LUTs as part of grades,  
see Chapter 140, “Node Editing Basics.” 

Alternately, if on-set color correction from the shoot been provided via a CDL-compliant EDL exported 
from one of several on-set grading solutions that are available, you can use the ColorTrace™ from CDL 
command to batch import grading information from another application. For more information on 
CDL import workflows, see Chapter 146, “Copying and Importing Grades Using ColorTrace.”

Selecting Timeline in the Node Editor

If your project’s workflow requires that you start out with even higher quality dailies, you can go 
ahead and manually grade individual clips as you would with any project. However, if you want to 
create a fast “one-light” adjustment for every clip in the Master Timeline at once, you can use the 
Timeline grade mode of the Node Editor in the Color page to apply a single correction simultaneously 
to every clip in the current Timeline. This is particularly useful as you can readjust the Timeline grade 
as much as you like, and the changes are automatically applied to every clip in the Timeline. For more 
information, see Chapter 140, “Node Editing Basics.” 
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Step 4–Export Media Suitable for Editing
Once you’ve organized your clips, synced the dailies, and applied whatever grading is necessary for 
the purpose at hand, you’ll use the Deliver page to set up the format, file naming convention, and 
organization of the media you’re outputting for editing or finishing.

Deliver page with several jobs set up for rendering

Furthermore, if you need to apply a window burn, watermark, or logo to the media you’re processing, 
that can be accomplished using the Project panel of the Data Burn-In window, available by choosing 
Workspace > Data Burn-In. Window burns can be formatted with a lot of flexibility, and are written 
out to media that’s either rendered or output to tape. For more information, see Chapter 12, 
“Data Burn-In.”

Choosing metadata to display onscreen in the Data Burn-in window
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Once you’ve selected the appropriate render settings and window burn options, you can output one 
or several versions of the media, to accommodate jobs where you need to provide several media 
deliverables. For more information on setting up and using the Deliver page, see Chapter 186, “Using 
the Deliver Page.”

Step 5–Reconform Media to an EDL, AAF, 
OTIO, or XML Project File
Once the offline media you’ve delivered has been edited in whichever NLE is used for the project, 
it’s simple to reimport the edited project via an AAF, XML, OTIO, or EDL file, depending on which is 
most suitable to your application. This edit data can be used to reconform the original media that you 
imported into the Media Pool, so that you immediately have access to whatever graded adjustments 
you made to create the offline media, as applied to the source media. 

Importing AAF, XML, OTIO, or EDL files in the Edit page creates new timelines, and you can import 
multiple subsequent Timelines to accommodate changes that have been made to the edit, if you 
find yourself grading a project that is in progress editorially. In fact, depending on how you set up 
your grades, you can use remote versions which will automatically ripple to follow each clip when you 
import a re-edited version of the program as a new timeline, saving you from having to recreate your 
work. For more information on using remote versions, see Chapter 139, “Grade Management.”

Step 6–Output Final Media for Finishing
Once you’re finished with your final grade, you’ll again use the controls of the Deliver page to render 
the program’s final media, either as individual clips for a round-trip workflow, or as a single media file 
or image sequence for delivery as a digital master.
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Chapter 58

Conforming 
XML Files
XML is one of the most straightforward methods of bringing edits 
with as many video tracks as you need from different NLEs into 
DaVinci Resolve. 

XML import has the added benefit of allowing a variety of supported effects to be imported along with 
the edit data, as well as multiple tracks of video data. 

This chapter covers the relatively simple procedure used to import XML projects into DaVinci Resolve. 
This can be for a one-way trip, in which you’re finishing a project in DaVinci Resolve, or as part 
of a round-trip workflow, in which you return to the NLE of origin for finishing. XML round-trip 
workflows are fairly simple; for more information on exporting individual clips, see Chapter 187, 
“Rendering Media.”

Contents
More About Conforming XML Files  1105

Importing XML Project Files  1105
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More About Conforming XML Files
DaVinci Resolve can import projects that were exported to the Final Cut Pro 7 or Final Cut Pro X XML 
formats.  Adobe’s Premiere Pro and Autodesk Smoke and Flame Premium are also capable of using 
the Final Cut Pro XML project exchange format to accommodate round-trip workflows. However, for 
the best results you need to make sure that you’re exporting XML from Premiere Pro version 5.5.1 or 
newer; ideally you want to export from the latest version of Premiere Pro that’s available. 

Exporting XML for use by DaVinci Resolve is straightforward, and there really aren’t any settings 
you need to manage when exporting an XML file other than the version of XML you want to export. 
For this reason, it’s best to do whatever timeline and/or media management you need to before 
XML export.

Manage Your Media Before Exporting an XML
In workflows using imported XML or AAF projects (or even EDLs), it’s easiest to relink and 
conform to the accompanying media files if they’re all located in a single directory path. 
Having media sorted into multiple directories is fine as long as they’re all within a single 
main directory that you can select at the appropriate stage of project import.

Importing XML Project Files
This section covers the Import AAF/EDL/XML dialog in much more detail. One procedure lets you 
accomplish any of the following workflows:

 — Importing an XML file and automatically conforming to and importing the media it’s linked to.

 — Importing an XML file and manually choosing another set of media, presumably in a different 
format or resolution, with identical metadata, to conform to instead.

 — Importing an XML file that’s linked to offline media derived from a camera original format, and 
automatically conforming it to and importing the camera original media.

Each of these workflows is possible by choosing the correct combination of options, each of which is 
described in the following procedure.

To load an XML file and automatically link to its referenced media:

1 Do one of the following:

 — From any page, choose File > Import Timeline (Shift-Command-I).

 — Open the Edit page, right-click anywhere in the Media Pool, and choose Timelines > 
Import > AAF/EDL/XML/DRT/ADL/OTIO.

2 Using the file dialog that appears, find the project file you want to import, and click the file to 
open it. The Load XML window appears, depending on your selection.
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Options when importing an XML file

3 Choose the options that are applicable to your particular project. By default, these options are 
based on metadata within the file you selected.

 — Source file: The file you selected in the previous step.

 — Import timeline: If there are multiple sequences within the selected XML source file, this 
pop-up menu lets you choose which sequence to import as a DaVinci Resolve timeline.

 — Timeline name: The name of the Timeline you’re about to create. This defaults to the name of 
the sequence that was exported, but you can change it if you like.

 — Master timeline start timecode: The timecode at which the imported timeline will start. This 
automatically matches the start timecode of the selected Import Timeline.

 — Automatically set project settings: Leave this option on to automatically change the frame 
size and frame rate settings in the Project tab of the Config page with those in this window. 
You can import timelines with frame rates that are different from the Project frame rate.

 — Automatically import source clips into media pool: Leave this checkbox on to automatically 
import the media referenced by the XML project file you selected into the Media Pool based 
on the embedded file paths. If the media files are not automatically found at these locations, 
you will be prompted to manually select a directory where the clips are located.

 — Ignore file extensions when matching: Turn this checkbox on if you want to manually 
choose a different directory of media to link to, for example if the XML you’re importing 
links to ProRes Proxy media, and you want to relink to another directory of corresponding 
ProRes 4444 or camera raw media.
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 — Use sizing information: Lets you import position, scale, and rotation transforms from the 
originating NLE via the imported XML project file. These transforms are stored in each clip’s 
settings in the Edit page Inspector.

 — Use color information: For Final Cut Pro X XML files only. This option lets you import a subset 
of color correction data from the Final Cut Pro X color board controls.

 — Import multi-channel audio tracks as linked groups: Turn on this checkbox if you want to 
import multi-channel audio, such as stereo, 5.1, and 7.1 audio into individual mono timeline 
tracks that are linked together in the Fairlight page. For more information about Linked 
Groups, see Chapter 167, “Setting Up Tracks, Busses, and Patching.” If this checkbox is turned 
off, multi-channel audio will be imported into multi-channel audio tracks in the Timeline.

 — Set timeline resolution to: Two fields let you specify the width and height of the frame size 
you want to work at in DaVinci Resolve. The default is whatever resolution is specified in the 
XML file being imported.

 — Timeline frame rate: By default, this is derived from the frame rate of the XML file being 
imported. If you’re importing an XML file into a project that already has media in the Media 
Pool, the Timeline frame rate is locked and cannot be changed.

 — Use drop frame timecode: By default, this is derived from the XML file being imported.

 — EDL frame rate: By default, this is derived from the frame rate of the selected file.

 — Use drop frame timecode: By default, this is derived from the frame rate of the selected file.

 — Mixed frame rate format: This pop-up menu lets you choose the method used to conform 
mixed frame rates for rendering and playback. You can choose the “Final Cut Pro 7” or “Final 
Cut Pro X” methods of conform, while for projects imported from Media Composer, Premiere 
Pro, Smoke, or other NLEs, you should leave this set to “DaVinci Resolve.” This pop-up menu 
also appears in the Load XML dialogs when you import a project.

4 After choosing all necessary settings, click OK.

5 Assuming you left “Automatically import source clips into media pool,” turned on, if the media 
linked to by the XML file is not in the expected disk location, or if you turned on the “Ignore file 
extensions when matching” checkbox, then another dialog appears prompting you to choose the 
folder within which the media for this project is stored. Do one of the following:

 — If you want to try to relink to media in another disk location: Click Yes, and then navigate 
to the folder containing your media (all subfolders will be automatically traversed as well), 
select it, and click OK.

 — If you want to just import the Timeline with all offline clips: Click No.

 

A prompt appears if all the media was not found
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IMPORTANT: It’s always possible to choose the top level of any volume to automatically 
find all media in any directories located within, but if the volume is large and full of 
many files, scanning every folder and document of the volume may be an extremely 
time-intensive process.

6 If you clicked Yes to selecting another folder, then use the folder selection dialog to navigate to 
another folder, and click Ok. You can cycle through this process as many times as you need to until 
you’ve found all the media that timeline is linked to.

Selecting the source folder for your XML imported clips

The XML file is imported. A new timeline and the referenced media files appear in the Media 
Pool, and the Timeline is opened so you can see its contents. Clips that could not be linked to a 
corresponding file on disk appear red in both the Media Pool and Timeline to indicate that they’re 
offline and unlinked.

TIP: You can open the Edit Index and choose Filter Offline Clips from the option menu 
to see a list of all offline clips in the current Timeline.
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Chapter 59

Conforming 
AAF Files
AAF (Advanced Authoring Format) is a project exchange format, 
originally developed by the Advanced Media Workflow Association 
(AMWA). Commonly used video applications that export 
project data in the AAF format include Avid Media Composer, 
Avid Symphony, Autodesk Smoke and Flame Premium, and 
Adobe Premiere Pro.

This chapter includes detailed information about recommended workflows for moving projects from 
Media Composer (or Symphony) to DaVinci Resolve for grading, either as a one-way trip, or as a round-
trip workflow in which you return to Avid Media Composer for finishing. Since Media Composer round-
trip workflows have many variables, this is covered in depth within this chapter.

The end of this chapter also describes how to import audio projects from Pro Tools that have been 
exported to AAF.
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Step 6–Copy the Graded Media to Avid MediaFiles  1121
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Supported Media Types in 
AAF Workflows
Media Composer provides several methods of ingesting and managing compatible media formats. 
Ultimately, which formats are suitable for a Media Composer to DaVinci Resolve one-way or round trip 
depends on whether they’re compatible with DaVinci Resolve.

There’s one other thing to keep in mind as you’re managing media in Media Composer; not all formats 
are compatible with all media management operations. This combination of format compatibility 
and operational compatibility requires you to carefully tailor your workflow around which media files 
you’ll be using.

Transcoding to DNxHD or DNxHR Always Works
Since DNxHD and DNxHR were developed to be Media Composer’s core codecs, workflows where you 
transcode other media formats to MXF-wrapped DNxHD/DNxHR before editing will always work, and 
are the simplest when round tripping between Media Composer and DaVinci Resolve. DaVinci Resolve 
supports both MXF-wrapped and QuickTime-wrapped DNxHD/DNxHR media. 

Linking to Media Using AMA and Consolidating
Avid Media Access (AMA) is a means of directly linking clips to media files in Media Composer without 
needing to either transcode them to DNxHD/DNxHR MXF files, or copy them to an Avid MediaFiles 
directory. While convenient, workflows involving media that’s linked using AMA require a bit more 
forethought.

Not all AMA-compatible media formats can be consolidated in Media Composer, which limits your 
ability to create a smaller, more portable collection of media to move into DaVinci Resolve. Whether or 
not an AMA-linked clip can be consolidated depends on its media format; Media Composer can only 
consolidate formats that it can write. For example, since Media Composer cannot write R3D media, 
then R3D media cannot be consolidated.
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Furthermore, not all AMA-compatible media formats are compatible with DaVinci Resolve. Simply 
being able to edit a media format in a Media Composer timeline doesn’t guarantee you can use it in 
DaVinci Resolve. The following table lists which media formats can be AMA-linked in Media Composer, 
which formats can be consolidated, and which are compatible for use in DaVinci Resolve.

If you’re prepping a sequence that uses a mix of media formats, some of which can be consolidated, 
and some of which can’t, you should transcode all clips that aren’t compatible with consolidation to 
an Avid native codec before beginning the process of consolidating media and exporting an AAF to 
DaVinci Resolve.

Fast Imported Media
Another wrinkle is that Media Composer supports a media ingest method called “Fast Import,” where 
imported media is quickly copied to the Avid MediaFiles directory by inserting the original image 
data using the original codec into an MXF wrapper. This is an extremely fast and efficient way to 
bring media into Media Composer projects, but the resulting files are not typically compatible with 
DaVinci Resolve.

On the other hand, keep in mind that any media format that can be Fast Imported can also be 
consolidated. If you’re planning to round trip a sequence that uses Fast Imported media, it’s 
recommended that you either transcode the Fast Imported clips to DNxHD prior to AAF export, or 
conform your exported AAF project to the camera original media in DaVinci Resolve instead.

TIP: Whenever you use a combination of media in your project that includes formats that 
aren’t compatible with DaVinci Resolve, you can use the “Transcode Video To” checkbox 
in the options of the Export As dialog when exporting an AAF project. This option lets 
you to transcode all media that isn’t a compatible format into a format that is compatible. 
Some non-standard frame sizes will not transcode in Avid and will return an unsupported 
resolution error.

Codec
Can be  
Natively AMA-Linked

Can be  
Consolidated

DaVinci Resolve 
Compatible

ARRI ALEXA Raw Non-native support No Yes

AVCHD Yes No Yes

AVC-Intra and Long GOP Yes Yes Yes

Blackmagic RAW Non-native support No Yes

Canon XF Yes Yes Yes

Cine (Phantom) Yes Yes Yes

CinemaDNG No No Yes

DVC PRO P2 Yes Yes No

QuickTime (ProRes) Yes Yes Yes

R3D (RED) Non-native support No Yes

Sony F65 Raw Yes No Yes
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Codec
Can be  
Natively AMA-Linked

Can be  
Consolidated

DaVinci Resolve 
Compatible

Sony HDCAM SR (SStP) Non-native support No Yes

Sony XAVC Yes Yes Yes

Sony XDCAM Yes Yes Yes

Compatible AMA-linked formats

Logged Errors When Importing AAF
If you turn on the “Import log messages as markers” checkbox in the Load AAF dialog, certain error 
messages that alert you to issues with the AAF import you’re trying to do will be added as markers 
with notes to the Timeline. You have an option, via a pop-up embedded within the text of this 
checkbox, of choosing the color of the markers used to store this information.

The following messages will create markers:

 — Transition type ‘XXXX’ is not supported in this release. A Cross Dissolve will be inserted.

 — Effect type ‘XXXX’ is not supported in this release. Plain clips will be imported.

 — SMPTE Wipe Transition type ‘XXXX’ is not supported in this release. A Cross Dissolve will be inserted.

 — Interpolation type ‘XXXX’ is not supported in this release. Linear interpolation will be used.

 — The clip ‘XXXX’ failed to link because the timecode extents do not match any clip in the Media Pool.

 — Mismatch between specified target timecodes ‘XXXX’ and located file timecodes ‘YYYY.’

 — No overlap between specified target timecodes ‘XXXX’ and located file timecodes ‘YYYY.’

 — Clip ‘XXXX’ in track ‘XXX’ at timecode ‘UNKNOWN’, with reel name ‘XXXX’ and filename ‘XXXX.’

 — Clip ‘XXXX’ in track ‘XXX’ at timecode ‘UNKNOWN’, with reel name ‘XXXX’ and filename ‘XXXX.’

 — File not found in search directories.

As of the time of this writing, this feature is only available when importing AAF files.

Simple AAF Import
This section covers the Import AAF, EDL, XML dialog in much more detail. One procedure lets you 
accomplish any of the following workflows:

 — Importing an AAF file and automatically conforming to and importing the media it’s linked to.

 — Importing an AAF file and manually choosing another set of media, presumably in a different 
format or resolution, with identical metadata, to conform to instead.

 — Importing an AAF file that’s linked to offline media derived from a camera original format, and 
automatically conforming it to and importing the camera original media.

Each of these workflows is possible by choosing the correct combination of options, each of which is 
described in the following procedure.
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To load an AAF file and automatically link to its referenced media:

1 Do one of the following:

 — From any page, choose File > Import Timeline (Shift-Command-I).

 — Open the Edit page, right-click anywhere in the Media Pool, and choose Timelines > 
Import > AAF/EDL/XML/DRT/ADL/OTIO.

2 Using the file dialog that appears, find the project file you want to import, and click the file 
to open it. The Load AAF window appears, depending on your selection.

Options when importing an AAF file

3 Choose the options that are applicable to your particular project. By default, these options are 
based on metadata within the file you selected.

 — Source file: The file you selected in the previous step.

 — Import timeline: If there are multiple sequences within the selected AAF source file, this pop-
up menu lets you choose which sequence to import as a DaVinci Resolve timeline.

 — Timeline name: The name of the Timeline you’re about to create. This defaults to the name of 
the sequence that was exported, but you can change it if you like.

 — Master timeline start timecode: The timecode at which the imported timeline will start. This 
automatically matches the start timecode of the selected Import Timeline.

 — Automatically set project settings: Leave this option on to automatically change the frame 
size and frame rate settings in the Project tab of the Config page with those in this window. 
You can import timelines with frame rates that are different from the Project frame rate.
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 — Automatically import source clips into media pool: Leave this checkbox on to automatically 
import the media referenced by the AAF project file you selected into the Media Pool based 
on the embedded file paths. If the media files are not automatically found at these locations, 
you will be prompted to manually select a directory where the clips are located.

 — Ignore file extensions when matching: Turn this checkbox on if you want to manually 
choose a different directory of media to link to; for example, if the AAF you’re importing 
links to ProRes Proxy media, and you want to relink to another directory of corresponding 
ProRes 4444 or camera raw media.

 — Use sizing information: Lets you import position, scale, and rotation transforms from the 
originating NLE via the imported AAF project file. These transforms are stored in each clip’s 
settings in the Edit page Inspector.

 — Import log messages as COLOR markers: Turn on this checkbox and choose a color from 
the accompanying drop-down menu for markers that will be placed in the Timeline with note 
text describing import errors that you might want to troubleshoot later.

 — Import multi-channel audio tracks as linked groups: Turn on this checkbox if you want to 
import multi-channel audio, such as stereo, 5.1, and 7.1 audio into individual mono timeline 
tracks that are linked together in the Fairlight page. For more information about Linked 
Groups, see Chapter 167, “Setting Up Tracks, Busses, and Patching.” If this checkbox is turned 
off, multi-channel audio will be imported into multi-channel audio tracks in the Timeline.

 — Import AAF to current timeline: Imports the AAF to the currently loaded Timeline, instead 
of creating a new timeline in the Media Pool.

 — Insert Additional Tracks: Automatically assigns new tracks to the Timeline, so the AAF 
referenced media does not overwrite current clips on the existing timeline. 

 — Insert with offset: Overwrites the AAF referenced media on the Timeline and offsets it 
by the amount set in timecode format.

 — Set timeline resolution to: Two fields let you specify the width and height of the frame size 
you want to work at in DaVinci Resolve. The default is whatever resolution is specified in the 
AAF file being imported.

 — Timeline frame rate: By default, this is derived from the frame rate of the AAF file being 
imported. If you’re importing an AAF file into a project that already has media in the Media 
Pool, the Timeline frame rate is locked and cannot be changed.

 — Use drop frame timecode: By default, this is derived from the AAF file being imported.

 — EDL frame rate: By default, this is derived from the frame rate of the selected file.

 — Use drop frame timecode: By default, this is derived from the frame rate of the selected file.

 — Mixed frame rate format: This drop-down menu lets you choose the method used to 
conform mixed frame rates for rendering and playback. You can choose the “Final Cut Pro 7” 
or “Final Cut Pro X” methods of conform, while for projects imported from Media Composer, 
Premiere Pro, Smoke, or other NLEs, you should leave this set to “DaVinci Resolve.” This drop-
down menu also appears in the Load AAF dialogs when you import a project.

4 After choosing all necessary settings, click OK.

5 Assuming you left “Automatically import source clips into media pool,” turned on, if the media 
linked to by the AAF file is not in the expected disk location, or if you turned on the “Ignore file 
extensions when matching” checkbox, then another dialog appears prompting you to choose the 
folder within which the media for this project is stored. Do one of the following:
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 — If you want to try to relink to media in another disk location: Click Yes, and then navigate 
to the folder containing your media (all subfolders will be automatically traversed as well), 
select it, and click OK.

 — If you want to just import the Timeline with all offline clips: Click No.

A prompt appears if all the media was not found

IMPORTANT: It’s always possible to choose the top level of any volume to automatically 
find all media in any directories located within, but if the volume is large and full of 
many files, scanning every folder and document of the volume may be an extremely 
time-intensive process.

6 If you clicked Yes to selecting another folder, then use the folder selection dialog to navigate to 
another folder, and click Ok. You can cycle through this process as many times as you need to until 
you’ve found all the media that timeline is linked to.

Selecting the source folder for your AAF imported clips

The AAF file is imported. A new timeline and the referenced media files appear in the Media Pool, 
and the Timeline is opened so you can see its contents. Simple nested clips should also come 
through. Clips that could not be linked to a corresponding file on disk appear red in both the 
Media Pool and Timeline to indicate that they’re offline and unlinked.
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TIP: You can open the Edit Index and choose Filter Offline Clips from the option menu to 
see a list of all offline clips in the current Timeline.

Supported AAF Timeline Features
The following additional AAF timeline information will automatically be imported to DaVinci Resolve:

 — Timeline Markers: Any timeline markers within the AAF will be imported. Timeline markers can 
also be exported from DaVinci Resolve to AAF for round-trip workflows.

 — Nested Clips: DaVinci Resolve will import AAF files with simple nested clips.

 — Boris Continuum FX: Boris Continuum FX effects and settings will be imported along with 
a timeline via AAF export. You’ll need to have the same Continuum suite of effects installed 
on both machines (OFX version for DaVinci Resolve, AVX for Avid). When importing an AAF, 
Boris Continuum effects that were used in the original NLE will appear on each affected clip in 
the resulting DaVinci Resolve timeline, with all previously applied parameters available in the 
Inspector. The Sapphire and Mocha suites are not available for AAF import at this time.

Performing an AAF Avid Round Trip
This section outlines a comprehensive workflow for creating projects in Media Composer that will 
be compatible with DaVinci Resolve, moving projects from Media Composer to DaVinci Resolve, then 
grading, rendering, and sending the final graded project back to Media Composer. The following steps 
include procedures covering the following tasks:

 — Ingesting all media as high quality MXF-wrapped DNxHD, then round tripping from Media 
Composer to DaVinci Resolve.

 — Importing and editing Resolve-compatible AMA-linked media formats, then round tripping from 
Media Composer to DaVInci Resolve.

 — Transcoding AMA-linked media files into offline-quality DNxHD clips for editing, then exporting 
an AAF file and reconforming it in DaVinci Resolve to high quality camera original media as part of 
the round trip.

Because there are so many variations in the way that Media Composer can ingest media and output 
AAF projects, you should familiarize yourself with the following procedures before continuing with 
your own project.

Step 1–Create a Project in Media Composer
1 When creating a project in Media Composer, take note of the image format details, as these 

should be matched in DaVinci Resolve. In particular, set the image format (e.g., 1080p/24) and 
raster dimensions (e.g., 1920x1080) to match your desired mastering format. Also, color space 
should be set to RGB 709 if you’re planning to send ingested/transcoded media from Media 
Composer to DaVinci Resolve for grading.
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NOTE: This information can also be found in the Avid Project Format tab.

2 Open your project, and ingest all necessary media into a new bin using one or both of the 
following methods:

 — Transcode media for editing: The simplest workflow for AAF import and round-trip 
workflows is to ingest transcoded, native MXF-wrapped DNxHD media using the Import 
command.

 — Import AMA-linked clips: You can also import AMA-linked clips, so long as all AMA-linked 
files are in a format that’s compatible with DaVinci Resolve. Keep in mind that not all AMA-
compatible formats can be consolidated in Media Composer. In this case, import AMA-linked 
media into a new bin using the Link to AMA File(s) command, and edit as usual.

Once you’ve ingested all necessary media, you can edit your project as you would any other, keeping 
in mind which effects are compatible with DaVinci Resolve. For more information on effects in 
Media Composer to DaVinci Resolve round trips, see Chapter 55, “Preparing Timelines for Import and 
Comparison.”

Step 2–Exporting an AAF for DaVinci Resolve
When you’re finished editing, you need to export an AAF that will conform the .mxf media you used 
in Media Composer into a DaVinci Resolve timeline. Two export configuration options are available, 
depending on whether DaVinci Resolve and Media Composer are on the same system.

1 Select the sequence you want to export, and choose File > Output > Export to File.

2 In the Export As dialog, type a name for the AAF file you’ll be exporting.

3 Choose a location to save the AAF. You can save it anywhere you like, but if you’re moving the 
project to another workstation, you may want to save it to a specific folder on a removable hard 
drive where you store your AAF and XML files. The location you choose can also be used as the 
location of the media that’s exported to accompany the AAF.

4 Click the Options button to open a more detailed window of export settings.

5 Turn on the AAF Edit Protocol checkbox. This option forces Media Composer to export a simplified 
AAF file that’s more compatible with the project exchange workflows of different applications.

6 Choose the appropriate option from the Export Method pop-up menu to configure how the AAF 
and its accompanying media will be exported. The option you choose depends on the following:

 — If Media Composer and DaVinci Resolve are on the same system: Choose “Link to (Don’t 
Export) Media” to export an AAF file that links to the existing media in its current location. 
Click the Audio Details tab and choose “Link to (Don’t Export) Media” from the Export Method 
pop-up menu.

 — If Media Composer and DaVinci Resolve are on different systems: Choose one of the two 
following export methods:

 — Copy All Media: For each source clip used, the entire corresponding media file is copied. 
This can be useful when you want to preserve the original relationship of each clip to the 
source media file it came from. However, be aware that you’ll potentially be exporting a lot 
of media when you use this option.
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 — Consolidate Media: This is a more efficient media management workflow for finished 
projects, since unused media will not be copied. You can specify additional handles to add 
to the beginning and end of each exported media file, in frames, in the Handle Length 
field. Should any media file and its handles overlap another media file and its handles, 
both will be combined into a single exported media file.

7 (Optional) If you’re using a combination of media in your project that includes formats that aren’t 
compatible with DaVinci Resolve, you can optionally turn on the “Transcode Video To” checkbox 
and choose a media format from the pop-up menu to the right. This option automatically 
transcodes all media in your sequence that doesn’t match the format specified in the pop-up to 
match that format.

8 If you’re copying or consolidating media to another drive, choose “Folder” from the Media 
Destinations Video/Data pop-up menu. Turn on the “Use Same Folder As AAF File” checkbox to 
save the exported media to the same folder you selected in step 3. If you leave this checkbox 
turned off, you can click Select Folder to choose another location.

9 Click Save, and when you return to the Export As dialog, click Save again.

Once export is complete, you’ll see a duplicate sequence and duplicate media populating your Media 
Composer bin, with the suffix “.Exported” appended to the sequence, and “.new” appended to each 
media clip. In the file system, the resulting folder contains an AAF file, and an Avid MediaFiles folder 
that contains the exported media.

Step 3–Conforming Your AAF in DaVinci Resolve
1 Open DaVinci Resolve and create a new project.

2 Before you do anything else, you need to set DaVinci Resolve to properly read the timecode and 
reel number information from the AAF files that Media Composer creates. Click the gear button 
at the lower right-hand side of the DaVinci Resolve window to open the Project Settings window, 
click General Options to reveal the Conform Options, and do the following:

 — Make sure that “Use Timecode” is set to “Embedded in the source clip.”

 — Turn the “Assist using reel names from the” checkbox on, and choose 
“Embedding in source clip file.”

Conform assistance with reel names embedded in the source clip
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3 Click Save.

4 Do one of the following:

 — From any page, choose File > Import AAF, EDL, XML (Shift-Command-I).

 — Open the Edit page, right-click anywhere in the Media Pool, and choose 
Timelines > Import > AAF/EDL/XML. 

5 When the File Selection window opens, select the AAF file you exported from Media Composer, 
and click Open.

6 When the Load AAF dialog appears, the settings you choose determine which media 
files the AAF will be conformed to:

Load AAF window conform options

 — To conform to the transcoded or AMA-linked media files you edited: Leave the 
“Automatically import source clips into media pool” checkbox turned on. 

 — To conform to a different set of camera original media files: Turn on both the 
“Automatically import source clips into media pool” and “Link to source camera files” 
checkboxes, which references the Source Name metadata that Media Composer/Symphony 
embeds in exported AAF files to track the correspondence in file naming between transcoded 
and camera original media.

 — To conform to a directory of media of your choosing: Turn on both the “Automatically 
import source clips into media pool” and “Ignore file extensions when matching” checkboxes.

 — To conform to media that’s already in the Media Pool: Turn off the “Automatically import 
source clips into media pool” checkbox. There must be clips in the Media Pool for this to work.

7 Additionally, make sure that the “Automatically set project settings” checkbox is on.

8 There are three other options that are relevant to AAF import:

Load AAF window conform options

 — Use Sizing Information: (Optional) Use this checkbox if you want to import position, scale, 
and rotate transform data from the originating Media Composer project into DaVinci Resolve.

 — Import log messages as COLOR markers: Turn on this checkbox and choose a color from 
the accompanying drop-down menu for markers that will be placed in the Timeline with note 
text describing import errors that you might want to troubleshoot later.
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 — Import multi-channel audio tracks as linked groups: Turn on this checkbox if you want to 
import multi-channel audio, such as stereo, 5.1, and 7.1 audio into individual mono timeline 
tracks that are linked together in the Fairlight page. For more information about Linked 
Groups, see Chapter 167, “Setting Up Tracks, Busses, and Patching.” If this checkbox is turned 
off, multi-channel audio will be imported into multi-channel audio tracks in the Timeline.

9 Click OK.

As long as the media remains where it was when you exported it from Media Composer, the timeline 
and all its media should now import. However, if the location of the media files you’re conforming 
to has changed, then you may need to identify the location of the media via an additional dialog. 
For example, if you’ve copied the media from the portable hard drive it was originally conformed to, to 
a faster storage volume, then a file dialog appears, requesting that you choose the folder containing 
the media used by your project. If prompted, do so and click OK.

Once import is complete, the Media Pool fills with the source media used by the imported project, and 
the edit appears as the current Timeline in the Edit page.

Step 4–Continue Editing, Grading, 
and Finishing the Project
Edit the Timeline in the Edit page and grade each clip in the Color page as you would any other. 
However, you should be aware that if you use the tools found in the Edit page to make any editorial 
changes to the timeline you’ve imported, your export options will change later on:

 — If you don’t make editing changes: Then you have the option to have DaVinci Resolve use the 
Avid AAF file that you originally imported to generate an updated one. This preserves audio and 
all other unsupported effects from the original AAF file, so that they reappear when you export a 
new AAF back to Media Composer. If you use this option, you need to make sure the original AAF 
file you import remains in the same location.

 — If you do make editing changes: Then you need to use the “Generate New AAF” command to 
export an AAF of the re-edited Timeline from DaVinci Resolve back to Media Composer. This newly 
generated AAF file will not include any effects that are not supported by DaVinci Resolve.

Step 5–Render Graded Media and 
Export a New AAF
1 When you’re ready to send a graded project back to Media Composer, select the Timeline you 

graded and open the Deliver page.

2 Choose “Avid AAF” from the Presets at the top of the Render Settings to load its settings.

Selecting the Avid AAF setup for round-trip
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3 In the Format section, choose the MXF codec you want to render to.

4 In the File section, choose the appropriate file destination path for the rendered media. The 
location you choose depends on whether Media Composer and DaVinci Resolve are on the same 
computer or not.

 — If Media Composer and DaVinci Resolve are on the same computer: Create a new folder 
within your Avid MediaFiles folder (Avid MediaFiles/MXF/) named with a number. Make sure 
you choose a previously unused number.

 — If DaVinci Resolve is on a different computer using different storage: Select any directory 
on the portable hard drive you’ll be using to bring the media back to the Media Composer 
workstation from which it came.

5 If you require handles for your rendered output, you can add handles in the Advanced Settings 
of the Video tab. When making any changes to the File render settings, make sure to leave 
the “Render Clip with Unique Filename” checkbox turned on to ensure that each clip rendered 
has a different file name as multiple clips in the edited sequence may originate from the same 
source clip.

6 In the Timeline, click Select Entire Timeline to select the entire Timeline for delivery, and then click 
Add to Render Queue at the bottom of the Render Settings to add the job you’ve set up to the 
Render Queue.

7 Click Start Render at the bottom of the Render Queue to initiate rendering.

The project renders, and an AAF is automatically exported to the same directory as the media 
you’ve rendered.

Step 6–Copy the Graded Media to Avid MediaFiles
1 For workflows where DaVinci Resolve and Media Composer are on separate workstations, locate 

the media directory containing the media files that were rendered out of DaVinci Resolve on the 
portable hard drive being used to transport the project back to your Avid workstation, and copy it 
into the Avid MediaFiles/MXF/ directory.

2 Rename the directory to be a number. Make sure you choose an unused number.

Step 7–Import the Graded AAF
1 Reopen the original project in Media Composer. If the media in the new directory of the 

Avid MediaFiles folder is in a compatible format, it will automatically be added to the internal 
database of media.

2 Create a new bin to contain the graded sequence you’re about to import.

3 Open the new bin, then choose File > Input > Import Media, select the graded AAF file that you 
exported from DaVinci Resolve, and click Open.

4 As long as the media is available in the Avid MediaFiles directory, the new bin you’ve created 
should automatically fill up with the clips that were rendered out of DaVinci Resolve, and a new 
sequence should appear.

5 Double click the sequence you’ve imported to open it into the Record monitor and Timeline, fully 
conformed with the color corrected clips from DaVinci Resolve. This sequence is now ready for 
finishing in Media Composer.
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Relinking Transcoded Media 
to AMA Media
This next workflow is useful when you’ve been editing transcoded, offline versions of processor- or 
bandwidth-intensive media, but you want to send the original high-quality source media (such as 
ALEXA or RED raw files) to DaVinci Resolve for grading. In certain situations, it may be better to 
reconform your sequence to the original AMA-linked media files in Media Composer before you round 
trip from Media Composer to DaVinci Resolve.

Step 1–Relink Your Transcoded Media 
to AMA-Linked Source
1 Edit a sequence using media that you’ve transcoded within Media Composer.

2 When you’re finished, open the bin that contains your project’s camera original media, and select 
the AMA-linked clips that correspond to the transcoded clips you’ve been editing.

3 Right-click the edited sequence in its bin, and choose Relink from the contextual menu.

4 When the Relink dialog appears, turn on “Select items in ALL open bins.” Select “Tape Name 
or Source File Name” under the Source Name settings, and leave the “Create new sequence” 
checkbox turned on.

A new sequence is created that is now linked to the AMA-linked camera originals.

Step 2–Export an AAF File
1 Select the new sequence that was created, and choose File > Output > Export to File.

2 Type a new name, choose a location for the file, and click Options.

3 Choose AAF from the Export As pop-up menu, and choose “Link to (Don’t Export) Media” from the 
Export Method pop-up menu.

4 Click Audio Details, and choose “Link to (Don’t Export) Media” from the Export Method 
pop-up menu.

5 Click Save to exit the Export Settings dialog, and then click Save again to export the file.

Step 3–Import the AAF, Grade, Render, and Export
1 Open DaVinci Resolve, and import the AAF file you exported into the Edit page. You’ll need to 

manually select the media in a second dialog.

2 Grade the project as you would any other.

3 When you’re done grading, use the AAF Round Trip option in the Deliver page to render the 
graded media into a new (numbered) directory in the Avid MediaFiles directory.

4 Open the Edit page, select the original AAF timeline you imported, right-click it, and choose Export 
AAF/XML. Pick a location for the file and click Save.
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Step 4–Reimport the AAF into 
Media Composer/Symphony
Open Media Composer, and import the AAF you exported from DaVinci Resolve. Your graded 
sequence is now ready for finishing.

Audio AAF Import from Pro Tools
Importing audio AAF timelines from Pro Tools (or any DAW software capable of exporting AAF) works 
similarly to the workflow for importing a video AAF from Media Composer that’s detailed at the 
beginning of this chapter. However, there are two methods you can use.

Import AAF, EDL, XML
Using the File > Import Timeline > Import AAF, EDL, XML command (Command-Shift-I), you can select 
a Pro Tools AAF. You’re presented with all the same import options as a Media Composer AAF, but 
what you end up with is an audio-only timeline, to which you can add a reference video if you need to.

Import AAF to Current Timeline
Using the File > Import Timeline > Import AAF to Current Timeline command lets you import an audio 
AAF to the currently open timeline. When you use this command, the import dialog presents similar 
import options, however, there are two additional options to choose from.

Additional options available when you use the 
“Import AAF to current timeline” command

The “Import AAF to current timeline” checkbox is on, and presents two options: 

 — Insert Additional Tracks: Lets you import the audio tracks starting at the beginning of the 
current timeline, placing them underneath the lowest track with existing audio in the Timeline.

 — Insert with offset: Lets you import the audio tracks with a specified offset from the beginning of 
the Timeline.
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Chapter 60

Conforming EDL Files
The edit decision list (EDL) is the lowest common denominator 
project exchange format there is, and most professional 
post-production applications are capable of exporting and 
importing projects in this format, including Media Composer, 
Autodesk Flame Premium, and the legacy Final Cut Pro 7. 

This chapter covers all workflows that let you import and conform timelines using the EDL format.
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Conforming EDL Files
DaVinci Resolve supports the CMX 3600 format for EDL import and export. The universality of EDLs 
is due, in part, to their longevity; different EDL formats have been in use for decades. It’s also due to 
their simplicity. At least as used by DaVinci Resolve, EDLs describe a very narrow range of editorial 
information, including clip arrangement, clip name (via embedded comments), video transitions (cuts 
or dissolves), and linear speed settings (percentage of fast forward or slow motion).

Another limitation is that EDLs only support a sequence of shots on a single video track. If you need 
to move projects with multiple tracks of audio and video, then you can export each track as a separate 
EDL from the originating application, and then right-click the timeline you want to import them into 
in the Media Pool and use the Timelines > Import > EDL to New Track contextual menu command to 
import each separate EDL to a new track of a single timeline in DaVinci Resolve. This is described later 
in this chapter.

NOTE: While the EDL format supports a variety of SMPTE-defined video transition codes, 
all EDL transitions are turned into cross dissolves of identical duration in DaVinci Resolve.

If you’re not familiar with the EDL format, each edit appears as a numbered event that contains the 
reel number, edit type, source timecode (In and Out points), and record timecode (In and Out points). 
Here’s a sample of a simple four event EDL:

TITLE:   Pool Shark Edit 

FCM: NON-DROP FRAME

001  REEL_ONE AA/V  C        10:59:23:01 10:59:28:16 01:00:00:00 01:00:05:15

002  REEL_ONE AA/V  C        11:39:48:15 11:39:51:13 01:00:05:15 01:00:08:13

003  REEL_ONE AA/V  C        13:16:30:21 13:16:34:19 01:00:08:13 01:00:12:11

004  REEL_ONE AA/V  C        14:09:43:16 14:09:44:20 01:00:12:11 01:00:13:15

Since DaVinci Resolve was originally designed to work by importing and exporting EDLs, there are 
several methods you can use to import projects using EDLs. In all cases, you must first add the media 
referenced by that EDL to the Media Pool before you can import its EDL.

The three primary workflows are:

 — Conforming EDLs to individual media files: Importing an EDL that references a collection of 
discrete media files that have already been imported into DaVinci Resolve.

 — Preconforming, or “notching,” a “flattened” master media file using an EDL: Importing an 
EDL that references a “flattened” master media file. Flattened master media files are created when 
an entire sequence is exported from an NLE as a single self-contained media file.

 — Importing an EDL directly to a new track of an existing edit: If you’re importing a multi-track 
video project, and the only means of doing so is using EDLs, you can export each track of the 
source project as an individual EDL, and then import each EDL into DaVinci Resolve directly into 
additional tracks of the same Timeline. This is also useful for workflows where effects clips are 
being managed on a separate track assembled elsewhere, that you can then import directly into a 
graded timeline to place many new effects clips all at once.

This description covers the different ways that EDLs can be used in DaVinci Resolve.
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EDL Export of a Project 
and Its Media
When using EDL workflows, it’s important to make sure that every clip in your edited sequence, and 
every source media file it’s linked to, has an appropriate reel number/reel name, and true timecode 
written into that file. When conforming EDLs, DaVinci Resolve requires reel names and accurate 
timecode to successfully conform the imported EDL timeline to media in the Media Pool.

To export an EDL that can be easily conformed by DaVinci Resolve, each NLE has particular settings 
that you should use. The primary supported format is CMX 3600, although DaVinci Resolve also 
supports the DEDL format exported by both Smoke and Flame. Also, most editing applications let 
you choose which video and audio tracks you want to export, and how to handle the start timecode 
for the selected sequence of clips you’re exporting. In general, it’s a good idea to make sure that the 
exported start timecode matches that of your sequence timeline.

There are other details, however, that vary by application. For example, when exporting an EDL from 
Media Composer using Tools > List Tool, you need to make sure that the Active Setting is set to Default 
EDL, and that the Output Format is set to CMX_3600. When exporting an EDL from Premiere Pro, you 
have the option of enabling Use Source File Name and Include Transitions. When exporting an EDL 
from the legacy Final Cut Pro 7, you need to make sure you set Reel Conflicts to Generic Edits, and turn 
on the File Names checkbox. Most applications provide other settings that are optional, including EDL 
notes of various kinds, but for a cleaner, easier to read EDL, you can turn these off if you like.

Conforming EDLs to 
Individual Media Files
The advantage of working with discrete media files is that they are the “purest” version of the media, 
without any effects (such as dissolves or superimpositions) “baked” into the visuals that might create 
complications when you’re grading. 

1 Before you import any media, make sure that the “Timeline frame rate” pop-up menu in the 
Master Settings panel of the Project Settings is set to a frame rate that matches your project and 
media. Otherwise, the EDL’s timecode will be misinterpreted.

2 Open the Media page, use the Media Storage browser to locate the media you want to add to the 
project, and add it to the Media Pool by right-clicking the enclosing directory and choosing one of 
the following commands:

 — Add Folder into Media Pool: Adds all compatible media files within that folder to the Media 
Pool. Subfolders are not traversed.

 — Add Folder and SubFolders into Media Pool: Adds all compatible media files from that 
folder, and all subfolders within that folder, to the Media Pool.

 — Add Folder Based on EDLs into Media Pool: Prompts you to choose an EDL. Only media 
referenced by that EDL is imported, and only the selected folder is searched for that media.

 — Add Folder and SubFolders Based on EDLs into Media Pool: Prompts you to choose 
an EDL. Only media referenced by that EDL is imported, and the selected folder and all 
subfolders are searched for that media.
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TIP: The “Add Folder...Based on EDLs” commands are useful for efficiently adding 
just the media you need to the Media Pool in instances where there might be many 
terabytes of unmanaged source media, most of which is unused.

3 Do one of the following:

 — From any page, choose File > Import Timeline (Shift-Command-I).

 — Open the Edit page, right-click anywhere in the Media Pool, and choose Timelines > 
Import > AAF/EDL/XML/DRT/ADL/OTIO.

A window appears prompting you to “Select a file to import.” 

4 Navigate to the EDL file you want to use, select it, and click Open. The Load EDL window appears.

5 Choose the options that are applicable to your particular project. All greyed out options are not 
editable, either because they’re not applicable, or are not defined by the Project Settings that are 
currently applied. The options you can set include:

 — Source File: The file you selected in the previous step.

 — Timeline name: The name of the Timeline you’re about to create. This defaults to the name 
of the EDL file you selected, but you can change this if you like, for example, to add the import 
date if this is a new version of the edit.

 — Automatically set project settings checkbox: Turn this option on if you want to overwrite 
the frame size setting in the Master Project Settings panel of the Project Settings. You cannot 
overwrite the Timeline frame rate when importing an EDL.

 — Set timeline resolution to: Two fields let you specify the width and height of the frame size 
you want to work at in DaVinci Resolve. This defaults to your Project settings, but can be 
overridden by turning on the “Automatically set project settings” checkbox.

 — EDL framerate: Choose the frame rate of the sequence that you exported as an EDL. You 
can use this option to convert the EDL frame rate from 30 to 24 frames per second if you set 
the Timeline frame rate to 24 fps and if the EDL frame rate is set to 30 fps; this is useful when 
an offline edit is done at 30 fps with media using 3:2 pulldown. Note that 25 fps to 24 fps 
conversion is not supported.

 — Use drop frame timecode checkbox: Only enabled if the EDL frame rate pop-up menu is set 
to 30 fps. Turn this on if your EDL uses drop-frame timecode.

6 When you’re finished choosing options, click OK.

The EDL is imported, a new timeline appears highlighted in the Media Pool, and its corresponding 
sequence of clips appears in the Timeline Editor if you’re in the Edit page. Clips that could not 
be linked to a corresponding file in the Media Pool appear with a red thumbnail to indicate that 
they’re unconformed. 
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Preconforming “Flat” 
Media Files to EDLs
Preparing an edited sequence for grading, along with each individual clip of media, can be time 
consuming for effects-intensive projects, or it may be an unnecessary step for a project with no 
effects whatsoever. 

In these cases, it can be simpler and quicker to export a flattened master media file that can 
be split back apart into its individual clips in DaVinci Resolve. This workflow is similar to a more 
traditional tape-to-tape workflow, except that you’re working from a digital master, rather than a 
tape-based master.

The easiest way to do this is to use the Preconform button in the Edit page to split a single master file 
that you’ve imported into the Media Pool back into individual clips in a new timeline.

To preconform a flattened master media file to an EDL:

1 Open the Media page, use the Media Storage browser to navigate to the flattened master media 
file that you exported containing the entire program, and double-click to add it to the Media Pool.

2 Right-click anywhere in the background of the Media Pool, and choose Timelines > Import > 
Preconformed EDL.

3 In the “Select an EDL file” dialog that appears, navigate to the EDL that matches the flattened 
master media file you had exported, select it, and click Open.

4 In the “Parse preconform options” dialog that appears, give the new Timeline a name, 
and click OK.

A new Timeline appears in the Media Pool list, and opening it in the Edit page shows the flattened 
media file with edits added to its video track that correspond to those from the selected EDL, ready for 
further editing and grading. The audio is left uncut, on the premise that you’re probably focused on 
grading the visuals in this workflow, and not on re-editing the audio.

Override Input Color Space 
of Clips in Preconform 
Workflows Using Color Management
When you preconform a flattened master media file using an EDL with the File > Import Timeline > 
Pre-conformed EDL command, and your project has Resolve Color Management or ACES enabled, you 
can now change the Input Color Space of each clip in the resulting Timeline independently. To do so, 
open the Color page, right-click the clips you want to customize, and choose an option from the Input 
Color Space submenu of the contextual menu.

This is useful in workflows where you’ve received a flattened media file that was output with clips in 
different color spaces, for example mixing Rec. 709 media with log-encoded clips of different kinds.
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Conforming “Flat” Media Files 
Using Split and Add
The second method of conforming an EDL to a flattened file is to use the “Split and Add” command 
in the Media page to split one or more master media files into individual clips that match those of an 
EDL, then importing the EDL itself in the Edit page in a second step. 

This method is useful if there are clips in different folders or volumes that you want to conform to 
a single EDL. For example, the majority of the first reel of a program may have been exported as a 
single flattened file, but the corresponding EDL may require that an additional folder of effects clips 
be added to the Media Pool to be fully conformed.

To split a flat media file in the Media page and import its EDL in the Edit page:

1 Before you import any media, make sure that the “Timeline frame rate” pop-up menu in the 
Master Settings panel of the Project Settings is set to a frame rate that matches your project.

2 Open the Media page, use the Media Storage browser to navigate to the flattened master media 
file that contains the entire program.

3 Select the flattened media file, right-click it, and choose “Split and Add into Media Pool.”

4 In the “Select EDL files for splitting clips” dialog that appears, navigate to the EDL that matches the 
flattened master media file, select it, and click Open.

5 Select the frame rate of the project from the File Conform Frame Rate dialog that appears. 
This frame rate should be identical to the “Timeline frame rate” pop-up you set in step 1. 

6 Choose the appropriate options in the “Enter handle size for splitting” dialog that appears:

 — Handle size in number of frames: Enter a number of frames to be added as handles to the 
first and last frame of the clip. This is useful when you’re using the “Split and Add into Media 
Pool” command to import only the referenced sections of a directory of individual media files.

 — Split Unreferred Clips: Useful when the referenced media files include segments that aren’t 
“referred to” by any events within the EDL used to split them. Turning this checkbox on adds 
all such unreferred clip segments to the Media Pool as separate clips, for possible later use.

7 Click Split & Add. The Media Pool fills up with individual segments of the flattened master media 
file, each of which matches an event in the EDL you used to split it.

8 To import the corresponding EDL to create a timeline with this media, do one of the following:

 — From any page, choose File > Import AAF, EDL, XML (Shift-Command-I).

 — Right-click anywhere in the background of the Media Pool, and choose Timelines > Import > 
AAF/EDL/XML.

9 In the “Choose a file to import” dialog that appears, navigate to the EDL that matches the 
flattened master media file, select it, and click Open.

10 Choose whatever options are necessary from the Load EDL dialog that appears (the default 
settings should work fine), and click OK.

The Master Timeline and the timeline you just imported appear in the Media Pool, the Conform EDL 
list updates with the events from the imported EDL, and the Timeline editor shows the edited clips, 
ready for grading. Clips that could not be linked to a corresponding file in the Media Pool appear with 
a red x to indicate that they’re unconformed.
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Importing an EDL to a New Track
This last procedure describes how to add an EDL, not as an individual new Timeline, but as an 
additional video track to an existing Timeline. There are many reasons you might want to do this. 
For example, if you need to move a multi-track project to DaVinci Resolve from an application that 
can’t export either AAF or XML project exchange files that DaVinci Resolve understands, you can use 
multiple EDLs. Simply export each track of the source project as an individual EDL, and then import 
each EDL into DaVinci Resolve as additional tracks of the same Timeline.

This is also useful for workflows where effects clips are being managed on a separate track assembled 
elsewhere, that you can then import directly into a graded Timeline to place many new effects clips 
all at once.

To import an EDL to a new track of an existing timeline:

1 In this procedure, you have the option of adding whatever media is required by the EDL you’re 
about to import to the Media Pool first, or you can add the media after the EDL has been 
imported. It’s your choice.

2 Open the Edit page, select a timeline in the Media Pool, then right-click it and choose Timelines > 
Import > EDL to New Track. A window appears prompting you to “Choose a file to import.” 

3 Navigate to the EDL file you want to use, select it, and click Open.

4 A new video track is created above any previously existing tracks, and events from the selected 
EDL are immediately loaded into it according to their record timecode positions. If you loaded 
the media needed by the new clips at the beginning of this procedure, that media should be 
conformed. Otherwise, you’ll need to track down the media files needed by the new unconformed 
clips and add it to the Media Pool now.
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Chapter 61

Conforming 
OTIO Files 
This chapter covers all workflows that let you import and conform 
timelines using the .otio and .otioz formats.
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More About Conforming OTIO Files
DaVinci Resolve supports the Open Timeline IO (OTIO) format for importing and exporting timelines 
between applications. OTIO is an open source media and timeline interchange format created by the 
Academy Software Foundation. It’s designed to be application and platform agnostic, allowing you to 
pass your timeline and its media assets between programs with more compatibility than AAF or XML.

Exporting OTIO for use by DaVinci Resolve is straightforward, and there really aren’t any settings you 
need to manage when exporting an OTIO file other than deciding if you want to export the Timeline 
only (.otio), or the Timeline and all its associated media (.otioz).

There are two different OTIO formats supported by DaVinci Resolve

.otio: These files contain just the metadata about the timeline and no associated media. They are 
small, portable, and require the end user to link the Timeline to their own copies of the media.

.otioz: These bundle files contain both the Timeline metadata and all of the Timeline’s media assets 
zipped together into one file. As a result this file can be very large, as it contains the full length media 
files of all assets used in the Timeline. However, it assures that whoever imports the file has all the 
media needed and is linked automatically to replicate the Timeline on their machine.

Importing OTIO Project Files
This section covers the Import OTIO dialog in much more detail. One procedure lets you accomplish 
any of the following workflows:

 — Importing an .otioz file automatically and its associated media.

 — Importing an .otio file and automatically conforming to and importing the media it’s linked to.

 — Importing an .otio file and manually choosing another set of media, presumably in a different 
format or resolution, with identical metadata, to conform to instead.

 — Importing an .otio file that’s linked to offline media derived from a camera original format and 
automatically conforming it to and importing the camera original media.

Each of these workflows is possible by choosing the correct combination of options, each of which is 
described in the following procedure.

To load an OTIO file and automatically link to its referenced media:

1 Do one of the following:

 — From any page, choose File > Import Timeline (Shift-Command-I).

 — Open the Edit page, right-click anywhere in the Media Pool, and choose Timelines > Import > 
AAF/EDL/XML/DRT/ADL/OTIO.

2 Using the file dialog that appears, find the project file you want to import, and select the file and 
press the Open button. The Load OTIO window appears, depending on your selection.
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Options when importing an .otio file

3 Choose the options that are applicable to your particular project. By default, these options are 
based on metadata within the file you selected.

 — Source file: The file you selected in the previous step.

 — Timeline name: The name of the Timeline you’re about to create. This defaults to the name of 
the sequence that was exported, but you can change it if you like.

 — Timeline start timecode: The timecode at which the imported timeline will start. This 
automatically matches the start timecode of the selected Import Timeline.

 — Automatically set project settings: Leave this option on to automatically change the frame 
size and frame rate settings in the Project tab of the Config page with those in this window. 
You can import timelines with frame rates that are different from the Project frame rate.

 — Automatically import source clips into media pool: Leave this checkbox on to automatically 
import the media referenced by the OTIO project file you selected into the Media Pool based 
on the embedded file paths. If the media files are not automatically found at these locations, 
you will be prompted to manually select a directory where the clips are located.

 — Ignore file extensions when matching: Turn this checkbox on if you want to manually 
choose a different directory of media to link to. For example, if the OTIO you’re importing 
links to ProRes Proxy media, and you want to relink to another directory of corresponding 
ProRes 4444 or camera raw media.
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 — Import multi-channel audio tracks as linked groups: Turn on this checkbox if you want to 
import multi-channel audio, such as stereo, 5.1, and 7.1 audio into individual mono timeline 
tracks that are linked together in the Fairlight page. For more information about Linked 
Groups, see Chapter 167, “Setting Up Tracks, Busses, and Patching.” If this checkbox is turned 
off, multi-channel audio will be imported into multi-channel audio tracks in the Timeline.

 — Set timeline resolution to: Two fields let you specify the width and height of the frame size 
you want to work at in DaVinci Resolve. The default is whatever resolution is specified in the 
OTIO file being imported.

 — Timeline frame rate: By default, this is derived from the frame rate of the OTIO file being 
imported. If you’re importing an OTIO file into a project that already has media in the Media 
Pool, the Timeline frame rate is locked and cannot be changed.

 — Use drop frame timecode: By default, this is derived from the OTIO file being imported.

 — EDL frame rate: By default, this is derived from the frame rate of the selected file.

 — Use drop frame timecode: By default, this is derived from the frame rate of the selected file.

 — Mixed frame rate format: This pop-up menu lets you choose the method used to conform 
mixed frame rates for rendering and playback. You can choose the “Final Cut Pro 7” or “Final 
Cut Pro X” methods of conform, while for projects imported from Media Composer, Premiere 
Pro, Smoke, or other NLEs, you should leave this set to “DaVinci Resolve.” This pop-up menu 
also appears in the Load OTIO dialogs when you import a project.

4 After choosing all necessary settings, click Ok.

5 Assuming you left “Automatically import source clips into media pool,” turned on, if the media 
linked to by the OTIO file is not in the expected disk location, or if you turned on the “Ignore file 
extensions when matching” checkbox, then another dialog appears prompting you to choose the 
folder within which the media for this project is stored. Do one of the following:

 — If you want to try to relink to media in another disk location: Click Yes, and then navigate 
to the folder containing your media (all subfolders will be automatically traversed as well), 
select it, and click OK.

 — If you want to just import the Timeline with all offline clips: Click No.

A prompt appears if all the media was not found

IMPORTANT: It’s always possible to choose the top level of any volume to automatically 
find all media in any directories located within, but if the volume is large and full of many 
files, scanning every folder and document of the volume may be an extremely time-
intensive process.
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6 If you clicked Yes to selecting another folder, then use the folder selection dialog to navigate to 
another folder, and click Ok. You can cycle through this process as many times as you need to until 
you’ve found all the media that timeline is linked to.

Selecting the source folder for your OTIO imported clips

The OTIO file is imported. A new timeline and the referenced media files appear in the Media 
Pool, and the Timeline is opened so you can see its contents. Clips that could not be linked to a 
corresponding file on disk appear red in both the Media Pool and Timeline to indicate that they’re 
offline and unlinked.

TIP: You can open the Edit Index and choose Filter Offline Clips from the option menu to 
see a list of all offline clips in the current Timeline.

Importing .otioz Files
The process for importing .otioz files is the same as above with the following difference: 

 — If an .otioz file was selected for import, the media assets will unzip themselves into a folder at the 
same place as the .otioz file and automatically link themselves. Make sure you have enough space 
for this.
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Chapter 62

Conforming 
ADL Files
This chapter covers all workflows that let you import and conform 
timelines using the AES31 Audio Decision List format (.adl).

Contents
More About Conforming ADL Files  1137

Importing ADL Project Files  1137

1136Import and Conform Projects | Chapter 62 Conforming ADL Files



More About Conforming ADL Files
DaVinci Resolve supports the AES31 Audio Decision List (.adl) format for import. ADL is a timeline 
interchange format created by the Audio Engineering Society. It’s designed to be application and platform 
agnostic, allowing you to pass your timeline and its media assets between digital audio workstations.

As of this writing DaVinici Resolve does not export ADL files.

Importing ADL Project Files
This section covers the Import of ADL files using one simple procedure.

The AES31 Audio Decision List (.adl) import progress dialog

To import and Audio Decision List (.adl) file and automatically link to its referenced media:

1 Do one of the following:

 — From any page, choose File > Import Timeline (Shift-Command-I).

 — Open the Edit page, right-click anywhere in the Media Pool, and choose Timelines > 
Import > AAF/EDL/XML/DRT/ADL/OTIO.

2 Using the file system dialog that appears, find the .adl project file you want to import, select the 
file and press the Open button.

3 DaVinci Resolve will import the timeline, and proceed to import all the associated .wav files with 
the ADL. An Import AES31 File dialog box will show you the progress of the import.

Unlike any of the other Timeline Import formats, there are no additional controls for importing an ADL 
file. The timeline and associated media are imported directly to the open bin in the Media Pool.
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